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Quick Reports

 

One of the most important tasks in data management is report genera-
tion. The Quick Report editor is one of two tools used to design 
reports. You use the Quick Report editor to create ad-hoc reports in the 
User environment. The other tool is the Form editor, which you can 
use to design reports in the Design environment. You should use an 
output form to design reports that require complex designs, program-
matic processing, or graphics.

With the Quick Report editor, you can:

 

■

 

Produce lists of records

 

■

 

Create break areas

 

■

 

Produce cross-tab reports

 

■

 

Compute summary calculations

 

■

 

Use fonts and styles in the report

 

■

 

Define borders and background colors on a cell basis

 

■

 

Save and open quick report designs to disk

 

■

 

Select different output types such as HTML, text file, 4D View area, 
chart or print to disk.

The Quick Report editor produces reports from the current selection of 
records. Before you print a report, set the current selection to the 
records you want to include in your report.
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Interface

 

In the user environment the new Quick Report editor appears as 
follows:

This actually consists of two main areas:



 

Interface
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■

 

The Quick Report dialog, which will help you define the contents of 
the Quick Report area:

This part of the user interface is actually built in a 4D form. It provides 
a basic interface for end-users to create Quick Reports through a wizard 
or the field list to create a recport manually.

 

■

 

The actual Quick Report area:

This area is the area as it appears when a Quick Report area is inserted 
in a form. This is where actual columns and row contents are created, 
where sort orders are defined, etc. Also, this area includes toolbars that 
can turn into palettes, its own menu bar and contextual menus.
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For example, this area could be placed in a form as depicted below:

 

The Quick Report Wizard

 

When creating a manual Quick report, you can use a Wizard to guide 
you through the creation of the report.

To invoke the wizard, click the Wizard button in the quick Report 
Editor:



 

List Mode and Cross-tab Mode
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The wizard is then displayed:

To complete a quick Report, follow the instruction and navigate 
through the Wizard’s pages.

 

List Mode and Cross-tab Mode

 

In the Quick Report editor there are now two operation modes 
available:

 

■

 

a List mode
This is the default mode and was the only mode available in the 
previous version of the Quick Report editor. In that mode, reports 
would typically present records as a list with break levels where 
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accumulations would be performed.The following is a typical list quick 
report. 

 

■

 

a Cross-tab mode
This mode is a cross-tabular mode. It allows you to display your report 
as a two-dimensional table. This is useful when you want to display 
data from a data source broken down into categories that actually are a 
function of two other data sources. For example, if you sell products in 
several countries, a cross-tab form would let you display in a table how 
many of each product type was sold for each country.

The following is a typical cross-tab quick report.
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Quick Report Basics

 

This section describes basic operations used when working with the 
Quick Report editor to design a report.

 

Creating a New 
Quick Report

 

The Quick Report editor lets you create reports in the User 
environment.

��

❿❿❿❿

 

To design a quick report in List mode:

 

1 Choose Quick from the Report menu.

 

4

 

th

 

 Dimension displays the Quick Report editor. If an existing report 
design is displayed, choose 

 

New

 

 from the 

 

File

 

 menu or click the icon 
New in the file management toolbar to begin a new Quick Report 
design.

By default, the first time the Quick Report editor is called during a 
worksession the List mode is selected.

 

2 If the List mode is not selected, click the button List at the bottom left 
corner of the Quick Report editor:

��

❿❿❿❿

 

To design a quick report in Cross-tab mode:

 

1 Choose Quick from the Report menu.

 

4

 

th

 

 Dimension displays the Quick Report editor. If an existing report 
design is displayed, choose 

 

New

 

 from the 

 

File

 

 menu or click the icon 
New in the file management toolbar to begin a new Quick Report 
design.

 

2 If the Cross-tab mode is not selected, click the button Cross-Tab at the 
bottom left corner of the Quick Report editor:

 

Loading and Saving 
a Quick Report 
Design

 

You can save a quick report design as a file that you can open from the 
Quick Report editor. The quick report design includes all of your speci-
fications for the report, but not the data. By saving report designs, you 
can maintain a library of quick report designs that you can use depend-
ing on your needs.
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Note

 

If you do not save your design, it is displayed the next time you open 

 

the Quick Report editor in that worksession only. 

��

❿❿❿❿

 

To save a quick report design:

 

1 Choose Save as from the File menu.
OR
Click the Open icon in the file management toolbar.

 

4

 

th

 

 Dimension displays a create-file dialog box in which you can name 
the quick report design.

 

Note

 

Quick report files in 4

 

th 

 

Dimension for Windows are denoted by the file 

 

extension .4QR.

 

2 Enter a filename for the quick report and click OK. 

 

4

 

th

 

 Dimension saves the report as a file that you can open with the 
Quick Report editor. You can save the file on any available hard disk. 
Saving a previously saved or loaded report replaces the old report. 

 

Loading a Quick Report 
Design

 

When the Quick Report editor is open, you can load a saved design 
and use it to print a new report. You can use the same quick report 
design repeatedly to print different selections of records.

��

❿❿❿❿

 

To load a report design:

 

1 Choose Open from the File menu.
OR
Click the Open icon in the file management toolbar.

 

4

 

th

 

 Dimension displays an open-file dialog box displaying a list of 
available quick report designs. 

 

2 Double-click a filename or select a filename from the list and click OK.

 

4

 

th

 

 Dimension replaces the current design with the design you opened. 
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The Quick Report Editor

 

When you create a quick report, you can specify the following:

 

■

 

Columns that display fields or formulas, either from the current table 
or from related tables

 

■

 

Sort levels and order (list mode)

 

■

 

Summary calculations

 

■

 

display format

 

■

 

Text for labels

 

■

 

Formats for numeric and Boolean data

 

■

 

Font, font size, style, and justification for labels, summary calculations, 
and data

 

■

 

Background colors on a cell column or row basis

 

■

 

Borders

 

■

 

Page headers and footers
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The following illustration shows the major elements of the Quick 
Report editor in List mode.

Fields list

Sort list

Tool bars 
and menu bars

Mode 
selection buttons

Master Table
drop-down list

Break row

Title and detail rows
Column divider

Field list 

Cell

selection list
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The following illustration shows the major elements of the Quick 
Report editor in Cross-tab mode.

The Quick Report editor contains the following elements: 

■ Fields list  This list displays fields in the current table. You can view the 
names of fields in related tables by expanding the foreign key fields. A 
foreign key field has a plus sign (on Windows) or an arrow (on Macin-
tosh) to its left.

Note Only tables and fields which are visible appear in the Quick Report 
editor. For information about making tables and fields invisible, refer 
to the 4th Dimension Design Reference manual.

■ Column dividers  These lines indicate the boundaries between columns 
of the report.

■ Cells  A cell is the intersection of a row and a column.

■ Scroll bars  You use the scroll bars to view parts of the quick report 
design that extend beyond the area of the quick report form. 

■ Sort list/Sort order display area  

Fields list

Sort orders

Tool bars 
and menu bars

Mode 
selection buttons

Master Table
drop-down list

Title and detail rows
Column divider

Field list 

Cell

selection list
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■ In List mode, this list displays the sort order assigned to the report 
and indicates whether each sort level is ascending or descending. If 
your report will contain summary calculations from groups of 
records, you must sort the current selection on one or more fields. 

■ In Cross-tab mode, this area displays the sort order for each data 
source.

■ Quick Report area

■ List mode:
You use this area to design the report by dragging fields, adding for-
mulas, adjusting column widths, defining cell colors and borders.

Title row  The title row is repeated for each page.

Detail row  The detail row indicates the lowest level of the report.

Subtotal rows  These rows are created when sorts are created.

Column data sources  These titles are the actual data source 
references.

■ Cross-tab mode:
You use this area to design a cross-tab report by dragging fields, add-
ing formulas, adjusting column widths, defining cell colors and bor-
ders.

Title row
Detail row

Column data source

Grand total row

Data Sources

Last Column Title

Last row title

Total cells
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Data Sources  These two cells will house fields that will be used for the 
two categories of the array. The center cell can also accept fields 
sources and calculations at the same time.

Total cells  These cells are designed to house calculations on the 
column’s contents.

Title cells  These cells house the titles for the last column or the last 
row.

The following figures shows completed quick report designs and the 
relationship between the specifications in the design and the printed 
output.

List Report:
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Cross-tab Report:

Resizing Areas in the 
Editor

You can resize the various list and display areas in the Quick Report 
editor. Areas that can be resized are bordered by a raised line.

❿❿❿❿ To resize an area in the editor:

1 Move the pointer over the area border to change the pointer into a 
resizing pointer . 

2 Drag the border left or right to resize the area. 

The Quick Report Contextual Menu
The Quick Report editor has “hidden” contextual menus that make it 
easy to access certain row, column, and cell operations. Instead of 
making menu selections or working with the Cell or Column 
properties areas, you can perform certain operations by displaying a 
Quick Report contextual menu.

There are separate contextual menus for row, column, and cell 
operations.

❿❿❿❿ To use a contextual menu:
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1 Position the pointer in a cell, a row title, or a column heading and hold 
down the right mouse button (on windows) or press the Control key 
while cliking in the report area (Mac OS).
A contextual menu appears. The commands in the contextual menu 
depend on where your pointer is (i.e., a row label, column heading, or 
cell). Also, menu commands that are inappropriate for the particular 
row, column, or cell are disabled.

2 Choose the desired menu command

As with any contextual menu, this menu’s contents varies depending 
on which cell type is highlighted. Items available break into three 
main types:

■ Font attributes

■ Display formats

■ Standard calculations

■ Column or row management items

■ Cell borders

Font Attributes These items appear in the contextual menu when a cell, a column or a 
row is selected. Selecting a font attribute will apply it to the current 
selection (cell, row or column)The Font attribute items are appear as 
follow:

■ Font
Selecting this item displays the list of fonts installed on your machine 
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from which you can select the font that will apply to the items selected 
in the report area.

Once an item is selected, a check mark is displayed next to it.

■ Size
Selecting this item displays the list font sizes from which you can select 
the font that will apply to the items selected in the report area.

Once an item is selected, a check mark is displayed next to it.

■ Style
Selecting this item displays the list styles (plain, Bold, Italic, and 
Underline) from which you can select the font that will apply to the 
items selected in the report area.

Once an item is selected, a check mark is displayed next to it.

■ Justification
Selecting this item displays the list of justification attributes (Default, 
Left justified, Centered and Right justified).

Note Default is the default justification for this data type (left for number or 
otherwise right).

Once an item is selected, a check mark is displayed next to it.
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■ Font color
Selecting this item displays a palette of colors.

Display Formats These items appear in the contextual menu when either a cell or a 
column is highlighted. From the menu you can select one of the 4D 
default formats that match the data type of the column. Once selected, 
the format applies to the entire column, regardless of whether the 
current selection is a cell or a column. 

Summary Calculations These items appear in the contextual menu when the current 
highlighted cell belongs to either the Grand total row or to a break 
row.

Selecting an item will insert the corresponding calculation in the 
highlighted cell. Once an item is selected for a cell, a check mark is 
placed next to it.

Column and Row 
Management Items

There are several items that are dedicated to column or row 
management:

■ Hide
Selecting that item hides the current column or row. Once it is hidden, 
a check mark is displayed next to the item and the line or column is 
squared out.

■ Add Column
This item is displayed when a row is highlighted or nothing is highli-
ghted. Selecting that item displays the formula editor to allow you to 



Chapter 1  Quick Reports

24 Quick Report Editor Reference

define the data source for the new column. Once this is done the new 
column is added to the right of the rightmost existing column.

■ Insert
This item is displayed only when a column is highlighted in list mode. 
Selecting that item displays the formula editor to allow you to define 
the data source for the new column. Once this is done the new column 
is added to the left of the current highlighted column.

■ Delete
This item is displayed only when a column is highlighted in list mode. 
Selecting that item deletes the current highlighted column .

■ Edit
This item is displayed only when a column is highlighted in list mode 
or when a cell is highlighted in cross-tab mode. Selecting that item dis-
plays the formula editor to allow you to edit the data source for the 
current column (list mode) or for the current cell (cross-tab mode).

■ Automatic Width
This item is displayed only when a column is highlighted in list mode, 
or when any cell is highlighted in cross-tab mode. You can us this item 
to select or deselect the automatic width. When Automatic Width is 
selected, 4D will try to match the column size to the data so that the 
data fits on one line.

Borders These items appear in the contextual menu when a cell, a column or a 
row is selected. Selecting the item Borders displays the Borders dialog:
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Once defined, the border format is applied to the current selection 
(cell, row or column).

Working with the Quick Report Editor
This section describes the basic operations that you can perform in the 
Quick Report editor.

Selecting Rows, 
Columns, and Cells

When designing a List quick report, you need to select rows, columns, 
and cells in the quick report form. A cell is the intersection of a row 
and a column.

❿❿❿❿ To select a row:

■ Click on the row Title, Detail, Break, or Total markers on the row label. 

❿❿❿❿ To select a column:

■ Click above the Title row of a column. 

❿❿❿❿ To select a cell:

■ Click the cell.

Adding and 
Modifying Text

You can add or modify text in the quick report form to label parts of the 
report. For example, if you requested summary calculations, you can 
label them by adding text to other cells in the subtotal and Total rows.

You can add and modify text as follows:

■ Edit the text that 4th Dimension automatically adds to the Title row of 
the report

■ Insert text in empty cells of the Break and Totals rows

■ Insert the value of a Subtotal field in the Subtotal rows

■ Specify the font, font size, justification, and style for any text that 
appears in the report
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Adding Text

❿❿❿❿ To add text in a report cell:

1 Click twice on an empty cell in the quick report form.
A text insertion point appears in the cell.

If you are entering a label for a summary calculation, select a cell in the 
same row as the cell containing the calculation icons. You cannot enter 
text into the same cell that contains summary calculations.

2 Type the text in the cell. 

Modifying Text

❿❿❿❿ To modify text in a cell:

1 Double-click in a cell to get an insertion point and drag across the text 
in the cell you want to modify.
4th Dimension highlights the selected text.

2 Type the new text in the cell.

Specifying Font 
Attributes

While designing your quick report, you can specify different fonts, 
font sizes, justification, and styles. You can then apply these specifica-
tions to text, data, and summary calculations within rows, columns, or 
cells in the quick report.

If you assign specifications to the Detail row of the report, you will not 
see the results until you preview or print the report.

You can specify font attributes using either the Quick Report menu 
commands or the Quick Report contextual menu.

❿❿❿❿ To specify font attributes using the Quick Report menus:

1 Select the column, row, or cell where you want to apply the font.

2 Choose a font from the Font drop-down list.

3 Choose a font size from the font size drop-down list.

4 Choose a style or justification from the Style menu.
4th Dimension applies the font to any text, data, or summary calcula-
tions that appear in the selected area.

❿❿❿❿ To specify font attributes using the Quick Report contextual menu:

1 Hold down the mouse button on the row label, column header, or cell 
to which you want to apply the font attributes.
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A contextual menu appears.

2 Use the Font, Size, Style, or Justification hierarchical menus to change 
the font attributes as desired.

Adding Columns to 
the Report

You create columns by dragging field names from the Fields list in the 
to the quick report area. If you want to add a field from a related table, 
expand the foreign key field in the hierarchical list of fields to display 
the fields in the related table. You can add fields from related tables, 
provided that the relationship is automatic.

Note You cannot add or edit a column in cross-tab mode, since the report 
comes with all the needed columns.

❿❿❿❿ To add a field by Drag & Drop:

■ Drag the name of a field to the right of existing columns in the Quick 
Report area and release the mouse button.
4th Dimension creates a column for the field and places the field name 
in both the column header and the cell in the Header row. 

By default, 4th Dimension prints the field names as column heads at 
the top of each page in the quick report.

❿❿❿❿ To add a field using the contextual menu:
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1 Right-click (Windows) over an unused area of the Quick Report area or 
click over an unused area of the Quick Report while pressing the 
Control key.

2 Select the Add menu item.
The formula editor is displayed. Once you have entered either a for-
mula or a field and validated the dialog, the column is created.

Inserting Columns You can insert an empty column in a quick report. After you insert the 
column you can assign a field or a formula to the column.

❿❿❿❿ To insert a column:

1 Select a column.

2 Choose Insert from the Column menu.

OR
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Hold down the mouse button to display the Quick Report contextual 
menu and choose Insert.

The formula editor is displayed. Once you have entered either a for-
mula or a field and validated the dialog, the column is created.

Deleting Columns As you specify fields for your quick report, you may want to remove 
some columns to place them elsewhere. Or, you might want to delete 
the column from the report.

❿❿❿❿ To delete a column using the Quick Report menu bar:

1 Select the column you want to delete. 

2 Choose Delete from the Edit menu. 
4th Dimension removes the selected column from the quick report 
form.

❿❿❿❿ To delete a column using the Quick Report contextual menu:

1 Right-click on the column data Source (on windows) or click on the 
column data source while pressing the Control key.
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The Quick Report contextual menu appears.

2 Choose Delete Column from the contextual menu.

Replacing Columns You can replace a column in the quick report by dragging another field 
over it. You can also replace a field with a formula.

❿❿❿❿ To replace a column:

1 Drag a field from the Fields list to the column you want to replace.
OR
Select the column you want to replace and choose Edit from the 
Columns menu.
OR
Hold down the mouse button on the column header to display the 
Quick Report contextual menu and choose Edit.
The Formula editor appears.

2 If you displayed the Formula editor, enter a formula for the column.
If you want to assign a field to the column, you can simply use the 
field name as the formula.

When you print the quick report, 4th Dimension prints the results of 
the formula for each record that appears in the Detail row. 

See the section “Adding Formulas to a Quick Report” on page 32 for 
information about adding a formula to a quick report.

Sizing Columns By default, the Quick Report editor sizes columns automatically,as 
reflected in the Automatic Width button:
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It sizes each column based on the maximum length of data displayed 
in the column and any labels typed into the column. The Quick Report 
editor sizes columns at the time the report is printed. 

To view the widths of each column, preview the report to the screen. 
See “Generating a Quick Report” on page 52 for more information 
about previewing the report. 

Because selecting the Automatic Width button or contextual menu 
item changes the width of a column based on the maximum width of 
data in the records being printed, selecting different records can 
change the size of the columns. 

You can resize a column manually after deselecting the Automatic 
Width check box. When a column is set manually, text in the column 
wraps within the specified area.

❿❿❿❿ To manually resize a column:

1 Select the column you want to resize.

2 Deselect Automatic Width1. 

3 Move the pointer over the column divider in the quick report to 
change the pointer into a column width cursor . 

4 Drag the column divider to the left or right to resize the column. 

Moving Columns In List mode, as you specify fields for your quick report, you may want 
to move some columns to place them elsewhere.

❿❿❿❿ To move a column using the Quick Report tool bar:

1 Select the column you want to move. 

2 Click the move icon to move it to the right or to the left: 

4th Dimension moves the selected column.

1. You can deselect Automatic Width using either the button “Automatic 
width” in the toolbar Properties area or the Quick Report contextual menu 
for that column.
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❿❿❿❿ To move a column using the Columns menu:

1 Select the column you want to move. 

2 Select Move right or Move left from the Columns menu to respectively 
move the column to the right or to the left.
4th Dimension moves the selected column.

Adding Formulas to 
a Quick Report

You can add a formula to a column in a quick report. For example, you 
can add a formula that computes employees’ monthly salaries from an 
Annual Salary field.

❿❿❿❿ To add a formula:

1 Insert an empty column or click an existing column and choose Edit 
from the Columns menu.
OR
Double-click an existing column’s header. 
OR
Hold down the mouse button on an existing column header to display 
the Quick Report contextual menu and choose Edit.
4th Dimension displays the Formula editor, in which you can build a 
formula. If you selected an existing column, the formula you create 
will replace the previous contents of the column.

Note Make sure that the formula you create does not change the current 
selection. Changing the current selection will cause problems when 
you print the quick report since the report is based on the current 
selection. For information about commands and functions that change 
the current selection, refer to the 4th Dimension Language Reference.

2 Build the formula. 
OR
Click the Load button to retrieve an existing formula from disk.
To save the formula as a file that you can retrieve and use in another 
column or in another report, click the Save button and enter a file-
name in the dialog box.

If you click the Load button, 4th Dimension displays an open-file dia-
log box and asks you to select a file. When you load a file, it replaces 
any formula that currently appears in the Formula editor. After you 
load a formula, you can modify it in the editing area.
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3 Click OK to assign the formula to the column.
4th Dimension adds a new label to the column that identifies it as a 
formula. You can relabel the column by typing a label into the header 
cell for that column. 

Click the Cancel button to close the editor and return to the Quick 
Report editor without adding the formula.

Setting Borders
You can set the borders for cells in both cross-tab and list reports. The 
layout of the border setting dialog is dynamic to adapt to the nature of 
the different cells that can be displayed in a report design. For example 
the behavior of the center cell in a cross-tab report is different from the 
behavior of a detail cell in a list report. The center cell is repeated both 
horizontally and vertically for a cross-tab report whereas the detail cell 
in a list report is going to be repeated only vertically. Also, other cells 
may not be repeated at all (titles, for example).

❿❿❿❿ To display the Borders dialog:

■ The Borders dialog is displayed by highlighting a cell, column or row, 
and either selecting Borders in the contextual menu or selecting 
Borders from the Columns menu.

The dialog appears as follows:

The preview area adjust to the type of cell (or row or column) that was 
selected when the dialog was invoked. The outer lines represent the 
outer borders. 

Preview area

Shortcut buttons

Line thickness
selection area
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If the selected cell is a title cell (which is therefore not repeated), the 
outer lines represent the outer lines of the cell:

If the selected cell is a detail cell in a List report (which is therefore 
repeated vertically), the outer lines represent the outer lines of the cell 
repetition and the inner horizontal line represents the border between 
two cells in the sequence:

If the selected cell is the center cell in a Cross-tab report (which is 
therefore repeated both horizontally and vertically), the outer lines 
represent the outer lines of the repetition of cells and the inner line 
represent the borders between each cell generated from the center cell:
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The arrows are used to fill the border towards which they point, using 
the border thickness defined in the border thickness area and the color 
selected in the color drop-down list:

❿❿❿❿ To set the borders for a cell, a column or a row:

1 Highlighting a cell, column or row, and either select Borders in the 
contextual menu or select Borders from the Columns menu.
The Borders dialog is displayed.

2 Select the line thickness and color to use.
You can use different colors for different borders.

3 Select the borders using either the arrows or the shortcut buttons.
You will notice that some shortcut buttons are disabled to match the 
type of the cell you are editing.

4 Click OK to validate the changes
OR
Click Revert to revert to the original border settings.
OR
Click Cancel to discard the changes and close the dialog.
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Sorting Records
An important feature of the Quick Report editor is the ability to sort 
the records in your report. You sort records for two reasons:

■ To view records in a particular order,

■ To create groups of records and subtotal areas in the report for the pur-
pose of reporting summary calculations for groups.

Specifying a Sort 
Order for a List 
Report

You can specify a sort order at any time. For example, if you wanted to 
sort the records of salespeople by the Sales Region field, you would 
select the Sales Region column, and then set the Sorted property.

You can also sort on a formula by selecting the column that contains 
the formula and then clicking the Sorted check box or choosing 
Sorted from the Quick Report contextual menu for that column. See 
the section “Adding Formulas to a Quick Report” on page 32 for more 
information about adding formulas to quick reports.

❿❿❿❿ To specify the sort order using the field list:

■ Drag the Field you want to sort from the field list to the sort list.
OR
Highlight the field from the field list and click on the field insertion 
button:

The field is then added to the sort order.

You can set the sort order by simply clicking on the triangle next to 
the field in the sort list.

❿❿❿❿ To specify the sort order for a formula:
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1 Select Report Columns from the table selection drop-down list.

The list of columns present in the report is then displayed:

❿❿❿❿ To change the level of a Sort field:

1 Select the field in the sort list and display the contextual menu:

2 Select Up or Down to respectively move up or down the field in the 
sort levels.
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Deleting a Field or 
Formula from the 
Sort List

You can delete the any field or formula from the Sort list.

❿❿❿❿ To remove a field or formula from the Sort order:

1 Select the field or formula in the sort list and display the contextual 
menu:

2 Select Delete.
The file is then removed.

Sorting the Cross-Tab 
Values

In a Cross-tab report, the only values that can be sorted are the 
horizontal and vertical data sources (the two data sources that are used 
as categories in the final table).

❿❿❿❿ To sort the categories in a cross-tab report:

1 Click the sort indicators in the Sort order area:

The arrows display the sort order you just selected. When no arrow is 
displayed, no sort order is selected, values will be displayed in the order 
they appear in the selection.
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Subtotal Levels In a quick report, you set break levels to separate or “break” records 
into groups according to values in one or more sort fields. A Break or 
Subtotal area is printed at each break level. You can print summary 
calculations in the Break area. The summary calculations — sum, 
average, minimum, maximum, and count — are calculated for each 
group of records. 

Break levels are determined by the sort levels and Break rows. For 
example, if you sort records by Sales Region and create a Break row, 
4th Dimension inserts a break between each group of records that have 
the same sales region. These rows are autumotically inserted when a 
sort is defined:

After you add a Break row to the quick report, you can request sum-
mary calculations on each break. For example, you can insert a sum-
mary calculation in a Break row to display subtotals for sales from each 
state in a marketing region. Refer to the section “Adding Summary Cal-
culations” on page 40 for more information about adding summary 
calculations to Break and Total rows.

The label of a subtotal row indicates which change in value triggers the 
break.

Using the Values of 
Break Fields in 
Labels

You can improve the appearance and comprehensibility of your 
reports by labeling each Break row using the value of the Break field.

To request that the value of a Break field be printed in a label placed in 
the Break area, use the number sign (#) in the label. For example, the 
text “Total salaries for department #” will insert the department name 
(in this case, the value of the Department field) in place of the number 
sign when the report is printed.

The number sign does not need to be placed in the same column as the 
Break field. It will display the value of the Break field in any cell in the 
Break row.

Subtotal rows
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The following figure illustrates the use of the number sign in a label in 
the Break row.

Adding Summary Calculations
You can add summary calculations on the contents of fields and 
formulas to each Subtotal row and to the Totals row. In a cross-tab 
report calculations can be inserted in the center row.

The calculation buttons in the toolbars of the Quick Report editor 
identify the summary calculation options available for quick reports.

The following summary calculations are available.

■ Sum  totals the values in the report or break.

■ Minimum  displays the lowest value in the report or break.

■ Maximum  displays the highest value in the report or break.

■ Average  calculates the average of the values in the report or break.

Number sign 
used in label
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■ Count  calculates the number of records in the report or break.

These options also appear in the Quick Report contextual menu for 
cells in the Subtotal and Total rows or, for a Cross-tab report, in the 
total cells and the center cell.

■ List Reports
When you place a summary calculation in the Totals row, the calcu-
lation is done for all records in the report. If you place the summary 
calculation in a subtotal row, separate calculations are done for the 
records in each break.

■ Cross-tab reports
Summary calcutations will apply as follows

❿❿❿❿ To add a summary calculation:

1 Select a cell where you want to insert the summary calculation.
The Sum, Minimum, Maximum, and Average calculations work only 
on a numeric field or formula. 

2 Click as many summary calculation buttons as you like. 
Or
From the contextual menu, choose the desired summary calculations.

Applies to values 

Applies to values

in each column

in both the last column
and last line

Applies to values 
in each line

Applies to each 
cell of the table
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4th Dimension displays a calculation icon in the selected cell for each 
type of summary calculation you request. The following figure shows 
calculation icons in the Break and Total rows.

If you add more than one summary calculation to a cell, 
4th Dimension stacks the calculation icons on top of each other, as 
shown above.

Using Calculations 
and Column Values 
in Labels

You can insert summary calculations using the following codes. 

■ - ##S will be replaced by the sum at the break or subtotal value.

■ - ##A will be replaced by the Average.

■ - ##C will be replaced by the Count

■ - ##X will be replaced by the Max.

■ - ##N will be replaced by the Min.

■ - ##xx, where xx is a column number. This will be replaced by that 
column’s value, using its formatting. If this column does not exist, 
then it will not be replaced

These codes can be useful when you want to mix labels and data in a 
cell.

Displaying Repeated 
Values for Break 
Columns

In a report with subtotals, the columns which are used to group 
records so that summary calculations can be done are called Break 
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columns. In the report shown above, the Department field is a Break 
column since the records in the report are grouped by department.

When a report like this is printed, the values for the Break column are 
printed only once per break. In other words, a department name is 
printed only for the first record in the group and is not repeated until 
the department changes.

In some cases, you may want to repeat the values for the Break col-
umns so that they appear for every record in the Break area. You do so 
by selecting the Repeated Values column property. You can do so 
either by clicking the Repeated Values button in the toolbars , by 
choosing the Repeated Values menu command in the Quick Reports 
contextual menu for that column or, by selecting Repeated Values 
from the Columns menu item.

❿❿❿❿ To display repeated values for fields in a column:

1 Select the column by clicking above the Header row for that column 
and click the Repeated Values button.
OR
From the contextual menu for that column, choose Repeated Values.

The following figure shows the report at the top of this page after the 
Repeated Values check box has been checked for the Department 
Name column.

Nonrepeating 
break values
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Setting Display Formats
You can specify display formats for columns that contain numeric or 
alphanumeric (Alpha) data. For example, if you are displaying salaries 
in a column, you can add a numeric format to the Detail cell for the 
Salary field. If your report includes Alpha fields such as a telephone 
number or Social Security number, you can use an Alpha format.

Numeric Formats The following format places a dollar sign to the left of the number and 
allows up to 6 digits: $###,###

This format can display dollar amounts up to $999,999. 

You can also create custom display formats in the Database Properties 
dialog box and use them in Quick Report designs. For more informa-
tion about creating custom formats, refer to the 4th Dimension Design 
Reference manual.

Alpha Formats You can use an Alpha format for fields that contain string information. 
For example, Social Security number or telephone number fields can be 
formatted with an Alpha format. 

For example, the following format would be used to format Social 
Security numbers:

###-##-####

Numeric 
format



Chapter 1  Quick Reports

46 Quick Report Editor Reference

Entering the Display 
Format for a Field

You enter a display format or custom format by choosing it from the 
Quick Report contextual menu for the cell or by typing it into a cell.

❿❿❿❿ To enter a display format for a numeric or Alpha field:

1 Click twice in the Detail cell for a numeric or Alpha column.

2 Type a display format or the name of a style that you want to use as 
the display format.
The names of styles are preceded by a vertical bar (|).

❿❿❿❿ To choose a display format from the Quick Report contextual menu:

1 Position the pointer anywhere over the column, display the contextual 
menu and select a format from the fomat submenu.

The hierarchical menu will show display formats that are appropriate 
for the data type of the column. For example, if the field was a numeric 
format, the menu command would be “Numeric” instead of “Alpha” 
and the submenu would list only numeric formats. After you make 
your selection, you can edit the format normally.
If you have also requested summary calculations for that column, the 
format specified in the Detail cell will automatically be applied to the 
summary calculations. 

Display formats for 
Alpha fields
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Regardless of the display format, the count is always displayed as an 
integer without formatting symbols such as the dollar sign. 
Different formats can be applied to different columns in the report. 

Hiding and Showing Rows and Columns
4th Dimension lets you hide rows or columns in a quick report. If 
desired, you can show a hidden column or row.

Hiding rows is useful when you want the report to include only sum-
mary calculations. For example, hide the Detail row if you want to dis-
play only the summary calculations that appear in the Totals and 
Subtotal rows. You can also use this feature to hide a Break row or the 
Totals row.

You can hide a column if you need to use the column as a sort column, 
but do not want the report to display the column. 

You can hide a row using either a Quick Report menu command or the 
Quick Reports contextual menu.

Note You cannot hide a row or column in a cross-tab report.

❿❿❿❿ To hide a row or column using the menu command:

1 Select the row or column you want to hide.

2 Choose Hide from the Columns menu.

❿❿❿❿ To hide a row using the contextual menu:
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1 Display the contextual menu when the mouse pointer is placed over 
the column or row label:

2 Choose Hide from the contextual menu.
4th Dimension displays the column in gray to remind you that the row 
will not appear when you print or preview the quick report.

Showing a Hidden 
Row or Column

When a row or column is hidden, a check mark is displayed next to the 
Hide menu command in the Columns menu and Quick Report 
contextual menu displays Show. You can display a hidden row or 
column choosing Hide again from either the Columns or contextual 
menu. When you do so, the row or column is displayed normally in 
the Quick Report area.

Hidden row

Hidden column
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Adding Page Headers and Footers
Before printing a quick report, you can add page headers and footers. 
You specify page headers and footers in the Headers and Footers dialog 
box. Use this dialog box to do the following:

■ Add page header and footer text or picture,

■ Use separate text for left, center and right for the header and footer. 

■ Specify the size of the page header and footer areas,

■ Specify fonts, font sizes, and font styles for page header and footer text,

■ Insert codes that add page numbers and the date and time to your 
reports.

You can only specify page headers when printing to a printer. See the 
section “Generating a Quick Report” on page 52 for more information 
about alternate output devices.
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❿❿❿❿ To add page headers and footers:

1 Choose Headers and Footers from the File menu.
The Headers and Footers dialog box appears.

The Header and Footers dialog box lets you specify both headers and 
footers from the same screen. You use the header/footer selection drop-
down list to specify either the header or footer.

2 Choose Header or Footer from the header/footer selection menu.

3 Enter the header or footer height in the Height area. 
When you first enter the dialog box, the header and footer heights are 
set to 25 points each. You can change values for the height and can 
change measurement scale to enter values in inches or centimeters.

As you enter the header and footer height, the dotted lines on the page 
preview area change to indicate the size of the header and footer as 
they will appear on the printed report.

Page preview 
area

Height

Picture 
insertion 
areat

Header/Footer
 drop-down list

Picture 
insertion 
areat
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4 If you want to use a picture, paste it in the picture area:

5 Select its alignment by clicking on the alignment icons:

6 If you want the height of the picture to become the height of the 
header/footer, click the Apply button.

7 Select an entry area and type the header or footer text.

To the right of each entry area, there are three buttons that let you 
enter variables into the entry area. 

You can insert the current page number, time of execution, or date of 
execution.

You can also directly use the code for the variables: #H, for the time, 
#D for the date and #P for the page number.

Inserts the current time

Inserts the current date

Inserts the current page
number
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8 Assign the font attributes for the header/footer.

9 Click OK, to validate the changes.

Generating a Quick Report
After you have completed your report design, you can “print” the 
quick report. You can print a quick report to a variety of output types:

■ On the standard printer selected

■ To disk

■ To a graph

■ To a 4D View document

■ To an HTML document

❿❿❿❿ To select an output device:

■ Choose Destination from the File menu. 

The Print Destination hierarchical menu contains three items.

Printer This option uses the printer you have chosen in your current print set-
tings. If you are printing to a printer, you can preview the report before 
printing it. 

❿❿❿❿ To print to a printer:

1 In the File menu, choose Printer from the destination submenu. 
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2 Select Generate from the File menu. 

3 Choose the settings that are appropriate for your report and click the 
OK button.

Disk File This option sends your quick report to a disk file that you can open 
and modify with other applications, including text editors and spread-
sheets. This option exports the records in the quick report to a text file.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To print to a disk file:

1 In the File menu, choose Disk File from the Destination hierarchical 
menu.

2 Choose Generate from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click the OK button.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to a file, 4th Dimension returns you to the 
Quick Report editor. Remember to change the output device if you 
want to resume sending a quick report to a standard printer.

Print to Graph This option directs the report to 4D Chart, 4th Dimension’s plug-in for 
plotting data. When you choose the Graph item in the Destination 
hierarchical menu, your report is presented as a graph rather than in 
tabular form. 4D Chart uses only the summary calculations and labels 
in the Break row. It uses the leftmost non-numeric column for the 
Values axis (the horizontal axis). Your graph can then be printed using 
4D Chart.
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To use the Graph feature, your report should:

■ Include from one to five numeric fields or formulas. These columns 
will be assigned to the values axis in the graph.

■ Use one type of summary calculation per numeric field.

For example, if you want to graph average salary by department, you 
should create a quick report with two columns, Department Name and 
Salary. Use the Average summary calculation for Salary.

❿❿❿❿ To print to a graph:

1 In the File menu, choose Graph from the Destination hierarchical 
menu.

2 Choose Generate from the File menu. 
4th Dimension graphs your data as a column graph. 

The following figure shows the graph produced from the quick report 
design described above.

You can use 4D Chart to select another graph type or print the graph. 

Printing to a 4D 
View Document

This option directs the report to 4D View, 4th Dimension’s plug-in for 
displaying data. When you choose the 4D View item in the 
Destination hierarchical menu, your report is presented as a 4D View 
window rather than in tabular form. 4D View uses all the data in the 
report.
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❿❿❿❿ To print to a 4D View document:

1 In the File menu, choose 4D View from the Destination hierarchical 
menu.

2 Choose Generate from the File menu. 
4th Dimension creates a 4D View window. 

Printing to an HTML 
Document

This option sends your quick report to an HTML file. This options uses 
the default HTML template unless is was changed programatically.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To print to an HTML file:

1 In the File menu, choose HTML File from the Destination hierarchical 
menu.

2 Choose Generate from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click the OK button.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to an HTML file, 4th Dimension returns you 
to the Quick Report editor. Remember to change the output device if 
you want to resume sending a quick report to a standard printer.
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2 Language

New Architecture
With the previous Quick Report editor, you could define a Quick 
Report through the standard interface, make that interface available to 
custom application and end-users through the REPORT command, but 
could not alter your Quick Report programmatically.

With 4D 2003, part of the Quick Report editor becomes an “internal” 
plug-in which makes it available as a plug-in area in addition to the 
more standard end-user access. It also comes with a new set of 
commands that lets you reproduce programmatically anything that 
can be done manually.

Hierarchical Reports
In the new Quick Report editor the handling of “hierarchical reports” 
was extended. In the previous version of the quick report editor, when 
you wanted to create a report on related data the starting table had to 
be a child table. Now, the master table for the report can either be a 
child table or a parent table.

How are relations propagated?

■ 1 to N
A selection in the 1 table conditions a selection in the N table that 
includes the child records of all the records in the 1 table.

For example, if the master table is a Customer table and its selection 
includes three customers, the selection in the child Invoice table 
includes all the invoices for these customers.



Chapter 2  Language

58 Quick Report Editor Reference

■ N to 1
A selection in the N table conditions a selection in the 1 table that 
includes all the parent records of all the records in the N table.

For example, if the master table is an invoice table and its selection 
includes invoices from different customers, the selection in the parent 
customer table includes all these customers.

It is important to understand that the propagation at the selection 
level is actually a “join” that includes the all the records for a set of 
given related values. Once relations have been propagated to the detail 
level, 4D goes through all the records of the detail selection and 
populates the related data at this point. This implies that, if a parent 
record has no child in the detail selection, it will not appear at all in 
the report.

Commands

QR BLOB TO 
REPORT

QR BLOB TO REPORT (area;blob)

The QR BLOB TO REPORT command places the report contained in blob 
in the Quick Report area passed in area. 

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid blob parameter, the error 9852 will be generated.

The following code allows you to display in MyArea, a report file 
named "report.4qr" located next to the database structure. The report 
file does not have to be created with 4D 2003, it can originate from 
previous versions.

C_BLOB($doc)
C_LONGINT (MyArea)
DOCUMENT TO BLOB("report.4qr";$doc)
QR BLOB TO REPORT(MyArea;$doc)

The following statement retrieves the Quick Report stored in Field4 
and displays it in MyArea.

Parameters Type Description
area Longint → Reference of the area
blob BLOB → BLOB that houses the report
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QR BLOB TO REPORT(MyArea;[Table 1]Field4)

QR Count columns QR Count columns(area) → Longint

The QR Count columns command returns the number of columns 
present in the Quick Report area.

If you pass an invalid area number, the error 9850 will be generated.

The following code retrieves the column count and inserts a column to 
the right of the rightmost existing column:

$ColNb:=QR Count columns(MyArea)
QR INSERT COLUMN(MyArea;$ColNb+1;->[Table 1]Field2)

QR DELETE 
COLUMN

QR DELETE COLUMN(area;colNumber)

The QR DELETE COLUMN command deletes the column in area whose 
number was passed in colNumber. This command does not apply to 
cross-tab reports.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid column number, the error 9852 will be 
generated.

The following example makes sure the report is a list report and deletes 
the third column.

If(QR Get report kind(MyArea )=qr list report)
QR DELETE COLUMN (MyArea;3)

End if

QR DELETE 
OFFSCREEN AREA

QR DELETE OFFSCREEN AREA(area)

Parameters Type Description
area Longint → Reference of the area
result Longint ← Number of columns in area

Parameters Type Description
area Longint → Reference of the area
colNumber Longint → Column number

Parameters Type Description
area longint → Reference of the area to delete
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The QR DELETE OFFSCREEN AREA command deletes in memory the 
Quick Report offscreen area whose reference was passed as parameter.

If you pass an invalid area number, the error 9850 will be generated.

QR EXECUTE 
COMMAND

QR EXECUTE COMMAND (area;command)

The QR EXECUTE COMMAND command executes the menu command 
or toolbar button whose reference was passed in command. The most 
common use for this command is to execute a command after the user 
selected that command and your code intercepted it through the QR 
ON COMMAND command.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid command number, the error 9852 will be 
generated.

Value Command
500 Bold
501 Italic
502 Underlined
503 Left justification
504 Center justification
505 Right Justification
506 Compute sum
507 Compute Avg
508 Compute Min
509 Compute Max
510 Compute count
511 Plain
512 Default justified

1000 Font list
1002 Font color
1003 Background color
1004 Alt Background color

Parameters Type Description
area Longint → Reference of the area
command Longint → Menu command to be executed
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2000 New file
2001 Open file
2002 Save file
2003 Save as
2004 Revert to Saved
2005 Header and footer
2006 Page setup
2007 Print preview
2008 Execute

2050 View font palette
2051 View computations palette
2052 View background colors palette
2053 View standard palette
2054 View columns palette

2300 + First size menu
2399 + Last size menu

2500 Printer output
2501 Disk output
2502 Graph output
2503 4D View output
2504 HTML output

2600 Insert column
2601 Delete column
2602 Hide column
2603 Edit column
2604 Repeat value
2605 Auto column width 
2606 Format menu (contextual menu)
2607 Hide line
2608 Add column
2609 Repeat value
2610 Totals Spacing
3002 Move Left
3003 Move Right
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QR Find column QR Find column (area; expression) → Longint

The QR Find column command returns the number of the first column 
whose contents match the expression passed in parameter.

expression can either be a string or a pointer.

Result equal –1 if nothing has been found.

If you pass an invalid area number, the error 9850 will be generated.

The following code retrieves the column number that holds the field 
[G.NQR Tests]Quarter and deletes that column:

$NumColumn :=QR Find column (MyArea;->[G.NQR Tests]Quarter)

or

$NumColumn :=QR Find column (MyArea; "[G.NQR Tests]Quarter")

followed by:

If ($NumColumn#-1)
QR DELETE COLUMN (MyArea ; $NumColumn)

End if

QR Get area 
property

QR Get area property (area; property) → Longint

The QR Get area property command returns 0 if the interface element 
(palette or menu bar) passed in property is not displayed; otherwise, it 
returns 1.

Parameters Type Description
area Longint → Reference of the area
expression String | 

Pointer
→ Column object

result Longint ← Number of the column

Parameters Type Description
area Longint → Reference of the area
property Longint → Palette designated
result Longint ← 0 = visible

1 = invisible
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The menu bar and toolbars are numbered from 1 to 6 (top to bottom) 
and the value 7 is dedicated to the contextual menu.

You can use the constants from the QR Area Properties theme to desig-

nate the interface item.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid property parameter, the error 9852 will be 
generated.

QR GET BORDERS QR GET BORDERS (area; column; row; border; line{;color})

The command QR SET BORDERS allows you to retrieve the border style 
for a border of a given cell.

area is the reference of the Quick Report area.

Property Constant Description
Menu bar QR view 

menubar (1)
Display status of the menu bar
(Displayed=1, Hidden=0)

Standard palette QR view stan-
dard toolbar (2)

Display status of the Standard palette
(Displayed=1, Hidden=0)

Style palette QR view style 
toolbar (3)

Display status of the Style palette
(Displayed=1, Hidden=0)

Computation 
palette

QR view compu-
tation toolbar 
(4)

Display status of the Computation 
palette (Displayed=1, Hidden=0)

Column palette QR view col-
umn toolbar (5)

Display status of the Column palette
(Displayed=1, Hidden=0)

Color palette QR view color 
toolbar (6)

Display status of the Color palette
(Displayed=1, Hidden=0)

Contextual 
menu

QR view contex-
tual menu (7)

Display status of the Contextual 
menu (Displayed=1, Hidden=0)

Parameters Type Description
area Longint → Reference of the area
column Longint → Column number
row Longint → Row number
border Longint ← Border value
line Longint ← Line thickness
color Longint ← Border color
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column is the column number of the cell.

row designates the row number of the cell.

■ if row equals -1, the title of the report is affected

■ if row equals -2, the detail of the report is affected

■ if row equals -3, the grand total of the report is affected

■ if row is a positive integer, it designates the Subtotal (break) level 
that is affected

You can use constants from the QR Rows for Properties theme to 
designate the row item. (qr title= -1, qr detail=-2, qr grand total=-3)

border is the value that indicates whose cell border is to be affected:

■ 1 indicates the left border

■ 2 indicates the top border

■ 4 indicates the right border

■ 8 indicates the bottom border

■ 16 designates the inside vertical border 

■ 32 designates the inside horizontal border

You can use constants from the QR Borders theme to designate the 
border item.

Note Unlike the command QR SET BORDERS, QR GET BORDERS does not 
accept a cumulative value.

line is the thickness of the line:

■ 0 indicates no line

■ 1 indicates a thickness of 1/4 point

■ 2 indicates a thickness of 1/2 point

■ 3 indicates a thickness of 1 point

■ 4 indicates a thickness of 2 points

color is the color of the line, it returns the value of the color applied to 
the line segment.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid column number, the error 9852 will be 
generated.
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If you pass an invalid row number, the error 9853 will be generated.

If you pass an invalid border parameter, the error 9854 will be 
generated.

QR Get command 
status

QR Get command status (area; command{; value})→ Longint

The QR Get command status command returns 0 if the command is 
disabled or 1 if it is enabled.

value is the value of the selected sub-item, if any. For example, if the 
command that was selected is the font menu (1000) and the font 
selected was “Arial“, value would return “Arial”, or if the command 
that was selected is a color menu (1002, 1003 or 1004), value would 
return the color number.

You can use the command in two types of contexts:

As a simple statement to determine whether a command is enabled or 
disabled.

In the method installed by QR ON COMMAND, it allows you to know 
which sub-item was selected. In that method, $1 is the reference of the 
area and $2 is the number of the command.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid command number, the error 9852 will be 
generated.

QR GET 
DESTINATION

QR GET DESTINATION (area; destination; {specifics})

Parameters Type Description
area Longint → Reference of the area
command Longint → Command number
value Text | 

longint
← Value for the selected sub-item

result Longint ← Command status

Parameters Type Description
area Longint → Reference of the area
type Longint ← Type of the report
specifics String |

Variable
← Specifics linked to the output type
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The QR GET DESTINATION command retrieves the output type of the 
report for the area whose reference was passed in area.

If you pass an invalid area number, the error 9850 will be generated.

QR Get document 
property

QR Get document property (area; option) → Longint

The QR Get document property command allows you to retrieve the 
display status for the print dialog or the unit used for the ruler.

■ If property equals 1, the command applies to display of the print 
dialog.

■ If result equals 1, the print dialog is displayed prior to printing.

■ If result equals 0, the print dialog is not displayed prior to printing.

The default value is 1.

■ If option equals 2, the command applies to the document unit.

■ If result equals 0, the document’s unit is points.

■ If result equals 1, the document’s unit is centimeters.

■ If result equals 2, the document’s unit is inches.

You can use the following constants, located in the QR Document 
properties constant theme: qr Printing Dialog and qr Unit.

If you pass an invalid area number, the error 9850 will be generated.

Destination Constant 
(value) Specifics

Printer QR Printer (1) N.A.
Text file QR Text File (2) File pathname
4D View QR 4D View Area 

(3)
N.A.

4D Chart QR 4D Chart 
Area (4)

N.A.

HTML file QR HTML File (5) Pathname to the HTML file

Parameters Type Description
area Longint → Reference of the area
property Longint → 1 = Print Dialog

2 = Document unit
result Longint ← Value for the option
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If you pass an invalid property value, the error 9852 will be generated.

QR Get drop column QR Get drop column(area) → Longint

The QR Get drop column command returns a value depending on where 
the drop was performed:

■ if the value is negative, it indicates a column number (i.e. -3 if the 
the drop was performed on column number 3)

■ if the value is positive, it indicates that the drop was performed on a 
separator preceding the column (i.e. 3 if the drop was performed 
after column 2). Keep in mind that the drop does not have to take 
place before an existing column.

If you pass an invalid area number, the error 9850 will be generated.

QR GET HEADER 
AND FOOTER

QR GET HEADER AND FOOTER(area; selector; leftTitle; centerTitle;rightTi-

tle; height{; picture}{; pictAlignment})

The QR GET HEADER AND FOOTER command allows you to retrieve the 
contents and size of the header or footer.

selector allows you to select the header or the footer. If selector equals 
1, the header information will be retrieved; if selector equals 2, the 
footer information will be retrieved.

leftTitle, centerTitle and rightTitle are the values for, respectively, the 
left, center and right header/footer.

Parameters Type Description
area Longint → Reference of the area
result Longint ← Drop value

Parameters Type Description
area Longint → Reference of the area 
selector Longint → 1 = Header

2 = Footer
leftTitle String ← Text displayed on the left side
centerTitle String ← Text displayed in the middle
rightTitle String ← Text displayed on the right side
height Real ← Header or footer height
picture Picture ← Picture to display
pictAlignment Longint ← Alignment attribute for the picture
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height is the height of the header/footer, expressed in the unit selected 
for the report.

picture is a picture that is displayed in the header or footer.

pictAlignment is the alignment attribute for the picture displayed in the 
header/footer.

■ If alignment equals 0, the picture is aligned to the left.

■ If alignment equals 1, the picture is centered.

■ If alignment equals 2, the picture is aligned to the right.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid selector value, the error 9852 will be generated.

The following code retrieves the values of the header titles as well as 
the header size and displays them in alerts:

QR GET HEADER AND FOOTER(MyArea;1;$LeftText;$CenterText;$Right-
Text;$height)
ALERT("The Left title is "+Char(34)+$LeftText+Char(34))
ALERT("The center title is "+Char(34)+$CenterText+Char(34))
ALERT("The right title is "+Char(34)+$RightText+Char(34))
ALERT("The height of the header is "+String($height))

QR Get HTML 
template

QR Get HTML template (area) → Text

The QR Get HTML template command returns the HTML template 
currently used for the Quick Report area. The returned value is a text 
value and includes all the contents of the HTML template.

If no specific template was defined, the template that is returned is the 
default template. Please note that no template will be returned if the 
output was not set to HTML file, either manually or programmatically.

QR GET INFO 
COLUMN

QR GET INFO COLUMN (area; colNum; title; object; hide; size; repeated-

Value; displayFormat)

Parameters Type Description
area Longint → Reference of the area
result Text ← HTML code used as template

Parameters Type Description
area Longint → Reference of the area
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List mode The QR Get Info Column command allows you to retrieve the parameters 
of an existing column.

area is the reference of the Quick Report area.

colNum is the number of the column to modify.

title is the title that will be displayed in the header of the column.

object is the actual object of the column (variable, field name or 
formula).

size is the size of the column in pixels. If size equals -1, the size is 
automatic.

repeatedValue is the status for data repetition For example, if the value 
for a field or variable does not change from one record to the other it 
may or may not be repeated when they do not change. If repeatedValue 
equals 0, values are not repeated. If repeatedValue equals 1, values are 
repeated. 

format is the display format. Display formats are the 4D formats 
compatible with the data displayed.

Cross-tab mode The QR GET INFO COLUMN command allows you to retrieve the same 
parameters but the reference of the areas to which it applies is different 
and varies depending on the parameter you want to set. First of all, the 
parameters title, hide, and repeateValue are meaningless when that 
command is used in cross-tab mode. The value to use for column varies 
depending on whether you want to retrieve the column size or the 
data source and display format.

colNum Longint → Column number
title String ← Title of the column
object FieldName| 

Variable
← Object assigned for that column

hide Longint ← 0 = visible
1 = invisible

size Longint ← Column size
repeatedValue Longint ← 0 = not repeated

1 = repeated
displayFormat Text ← Display format for the data

Parameters Type Description
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■ Column size:
This is a “visual” attribute, therefore columns are numbered from left 
to right, as depicted below.

The following statement sets the size to automatic for all the columns 
in a cross-tab report and leaves other elements unchanged.

For ($i;1;3)
QR GET INFO COLUMN(qr_area;$i;$title;$obj;$hide;$size;$rep;$format)
QR SET INFO COLUMN(qr_area;$i;$title;$obj;$hide;0;$rep;$format)

End for 

You will notice that since you want to alter only the column size, you 
have to use QR GET INFO COLUMN to retrieve the column properties 
and pass them to QR SET INFO COLUMN to leave it unchanged, except 
for the column size.

column = 1 column = 2 column = 3
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■ Data source (object) and display format
In this case the numbering of column operates as depicted below:

QR Get info row QR Get info row (area; row)→ longint

The QR Get info row command retrieves the display status of the row 
whose reference was passed in row.

row designates which row is affected by the command:

■ if row equals -1, the title display attribute is retrieved

■ if row equals -2, the detail display attribute is retrieved

■ if row equals -3, the grand total display attribute is retrieved

■ if row is a positive integer, it designates the subtotal (break level) 
whose display attribute is retrieved.

You can use constants from the QR Rows for Properties theme to 
designate the row item.(qr title= -1, qr detail=-2, qr grand total=-3)

result specifies whether the row is visible or hidden. If it equals 1, the 
row is set to hidden; if it equals 0, the row is set to visible.

If you pass an invalid area number, the error 9850 will be generated.

column = 2 column = 3 column = 1

Parameters Type Description
area Longint → Reference of the area created
row Longint → Row designator
result Longint ← 0= visible

1= hide
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If you pass an invalid row value, the error 9852 will be generated.

QR Get report kind QR Get report kind (area) → longint

The QR Get report kind command retrieves the report type for the area 
whose reference was passed in area.

■ If type equals 1, the report type is list

■ If type equals 2, the report type is cross-table

If you pass an invalid area number, the error 9850 will be generated.

QR Get report table QR Get report table (area) → Longint

The QR Get report table command returns the current table for the 
report area whose reference was passed in area.

If you pass an invalid area number, the error 9850 will be generated.

QR GET SELECTION QR GET SELECTION (area; left; top{; right}{; bottom})

The command QR GET SELECTION Returns the coordinates of the cell 
that is selected.

left is the number of the column that is the left boundary of the 
selection. If left equals 0, the entire row is selected.

Parameters Type Description
area Longint → Reference of the area
type Longint ← Type of the report

Parameters Type Description
area Longint → Reference of the area
table Longint ← Table number

Parameters Type Description
area Longint → Reference of the area
left Longint ← Left boundary
top Longint ← Top boundary
right Longint ← Right boundary
bottom Longint ← Bottom boundary
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top is the number of the row that is the top boundary of the selection. 
If top equals 0, the entire column is selected.

Note If both left and top equal 0, the entire area is highlighted.

right is the number of the column that is the right boundary of the 
selection.

bottom is the number of the row that is the top boundary of the 
selection.

Note If there is no selection, left, top, right and bottom are set to -1.

If you pass an invalid area number, the error 9850 will be generated.

QR GET SORTS QR GET SORTS(area;columns;{orders})

The QR GET SORTS command populates two arrays:

■ aColumns
This array includes all the columns that have a sort order.

■ aOrders
Each element of this array contains the sort orders for the matching 
column. 

■ If aOrders{$i} equals 1, the sort order is ascending.

■ If aOrders{$i} equals - 1, the sort order is descending.

If you pass an invalid area number, the error 9850 will be generated.

QR Get text 
property

QR Get text property(area;colNum; rowNum; property)→ Longint

Parameters Type Description
area Longint → Reference of the area
aColumns Array real ← columns
aOrders Array real ← sort orders

Parameters Type Description
area Longint → Reference of the area
colNum Longint → Column number
rowNum Longint → Break number
property Longint → Operator value for the cell
result Longint ← Value for the selected property
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The command QR Get text property returns the property value for the 
text attributes for the cell determined by colNum and RowNum.

■ area is the reference of the Quick Report area.

■ colNum is the number of the cell column.

■ rowNum is the reference of the cell row.

■ if rowNum equals -1, it designates the column title.

■ if rowNum equals -2, it designates the detail area.

■ if rowNum equals -3, it designates the column grand total.

■ if rowNum equals -4, it designates the page header.

■ if rowNum equals -5, it designates the page footer.

Note When passing -4 or -5 as rowNum, you still need to pass a column 
number in colNum, even if it is not used.

■ if rowNum s a positive value, it designates the corresponding subto-
tal (break level).

Note In cross-tab mode the principle is similar except for the row values that 
are always positive.

■ property is the value or constant of the text attribute to assign.

■ If property equals 1, the value is the font number as returned 
through Font list.

■ If property equals 2, the value is the font size expressed in points (9 
to 255).

■ If property equals 3, the value is the Bold style attribute (0 or 1).

■ If property equals 4, the value is the Italic style attribute (0 or 1). 

■ If property equals 5, the value is the font Underline style attribute (0 
or 1).

■ If property equals 6, the value is the font Color attribute (0 or 1).

■ If property equals 7, the value is the font Justification attribute (0 for 
default, 1 for left, 2 for center or 3 for right).

■ If property equals 8, the value is the background color.

■ If property equals 9, the value is the alternate background color.

If you pass an invalid area number, the error 9850 will be generated.
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If you pass an invalid colNum number, the error 9852 will be 
generated.

If you pass an invalid rowNum number, the error 9853 will be 
generated.

If you pass an invalid property number, the error 9854 will be 
generated.

QR GET TOTALS 
DATA

QR GET TOTALS DATA(area;colNum; breakNum; operator; text)

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid colNum number, the error 9852 will be 
generated.

If you pass an invalid breakNum number, the error 9853 will be 
generated.

List Mode The QR GET TOTALS DATA command allows you to retrieve the details of a 
specific break.

area is the reference of the Quick Report area.

breakNum is the number of the break whose data will be retrieved 
(subtotal or grand total)

Subtotal : between 1 and the number of Subtotal/sort.

Grand total : -3 / constant : qr grand total

colNum is the number of the column whose data will be retrieved

operator is the sum of all the operators present in the cell:

■ If operator equals 0, there is no operator.

■ If operator equals 1, the operator is Sum.

■ If operator equals 2, the operator is Average.

Parameters Type Description
area Longint → Reference of the area
colNum Longint → Column number
breakNum Longint → Break number
operator Longint ← Operator value for the cell
text String ← Contents of the cell
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■ If operator equals 4, the operator is Max.

■ If operator equals 8, the operator is Min.

■ If operator equals 16, the operator is Count.

text is the text present in the cell.

Note operator and text are mutually exclusive, so you either have a result 
returned through operator or through text.

Cross-tab Mode The QR GET TOTALS DATA command allows you to retrieve the details of a 
specific cell.

area is the reference of the Quick Report area.

colNum is the column number of the cell whose data is going to be 
retrieved.

breakNum is the row number of the cell whose data is going to be 
retrieved.

operator is the sum of all the operators present in the cell:

■ If operator equals 0, there is no operator.

■ If operator equals 1, the operator is Sum.

■ If operator equals 2, the operator is Average.

■ If operator equals 4, the operator is Max.

■ If operator equals 8, the operator is Min.

■ If operator equals 16, the operator is Count.

You can use constants from the QR operators theme to designate the 
operator. 

value is the text present in the cell.
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Here is a depiction of how the parameters column and break have to be 
combined in cross-tab mode:

QR GET TOTALS 
SPACING

QR GET TOTALS SPACING(area; subtotalNumber;value)

The command QR GET TOTALS SPACING allows you to retrieve a space 
above a subtotal row. It applies only to the list mode.

area is the reference of the Quick Report area.

subtotal is the subtotal level (or break level) that will be affected.

value defines the value of the spacing:

■ If value equals 0, no space is added.

■ If value equals 32000 a page break is inserted.

■ If value is a positive value, it expresses the spacing value in pixels.

■ If value is a negative value, it expresses the spacing as a percentage 
of the subtotal row. For example, -100 will set a space of 100% 
above the subtotal row.

colNum = 1 colNum = 2 colNum = 3

breakNum = 1

breakNum = 2

breakNum = 3

Parameters Type Description
area Longint → Reference of the area
subtotal Longint → Subtotal number
value Longint ← 0: no space

32000: inserts a page break
Positive value: spacing added at the 
top of the break level.
Negative value: proportional increase 



Chapter 2  Language

78 Quick Report Editor Reference

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid subtotalNumber, the error 9852 will be 
generated.

QR INSERT COLUMN QR INSERT COLUMN(area;colNumber; object)

The QR INSERT COLUMN command inserts or creates a column at the 
specified position. Columns located to the right of that position will be 
shifted accordingly.

If you pass an invalid area number, the error 9850 will be generated.

position is the number of the column, established from left to right.

The default title for the column will be the value passed in object.

The following statement inserts (or creates) a first column in a Quick 
Report area, inserts “Field1” as column title (default behavior) and 
populates the contents of the body with values from Field1.

QR INSERT COLUMN (MyArea;1;->[Table 1]Field1)

QR New offscreen 
area

QR New offscreen area -> Longint

The QR New offscreen area command creates a new Quick Report 
offscreen area and returns its reference.

QR ON COMMAND QR ON COMMAND(area;4DRepmethod)

Parameters Type Description
area Longint → Reference of the area
colNumber Longint → Column number
object FieldName | 

Variable |
Pointer

→ Object to be inserted in the column

Parameters Type Description
area longint ← Reference of the area created

Parameters Type Description
area Longint → Reference of the area
4DRepMethod String → Name of the replacement method
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The QR ON COMMAND command executes the method passed as 
4DRepMethod when a Quick Report command is invoked by the user, 
by the selection of a menu command or by a click on a button. If area 
equals zero, 4DRepMethod will apply to each Quick Report area until 
the database is closed or until the following call to QR ON COMMAND 
is made: QR ON COMMAND(0;"").

4DRepMethod receives two parameters:

 $1 is the reference of the area (Longint).

 $2 is the command number of the command that was selected 
(Longint).

Note When planning on compiling the database, it is necessary to declare 
both $1 and $2 as Longints, even if you do not use them.

If you want the initial command to be executed you need to include 
the following in the called method: QR EXECUTE COMMAND($1;$2).

If you pass an invalid area number, the error 9850 will be generated.

QR REPORT QR REPORT ({table; }document{; hierarchical}{; wizard}{; search}{;*})

Parameters Type Description
table Table → Table to use for the report, or Default 

table, if omitted
document String → Quick Report document to load
hierarchical Boolean → 0 = does not display N related tables 

(default)
1 = displays N related tables

wizard Boolean → 0 = wizard button is not displayed in 
the dialog (default)
1 = wizard button is displayed in the 
dialog

search Boolean → 0 = no search tools and master table 
choice(default)
1 = search tools and master table 
choice

* → Suppresses the printing dialog boxes
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QR REPORT runs a report for table, created with the Quick Report editor 
shown here.

■ document (string)
The document parameter is a report document that was created with 
the Quick Report editor and saved on disk. The document stores the 
specifications of the report, not the records to be printed. 

If an empty string ("") is specified for document, QR REPORT displays 
an Open File dialog box and the user can select the report to print.

If the document parameter specifies a document that does not exist (for 
example, pass Char(1) in document), the Quick Report editor is 
displayed. 

■ hierarchical (boolean)
The hierarchical parameter defines whether the N tables are displayed 
in the field selection list. 
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■ wizard (boolean)
This parameter indicates whether the Open Wizard button is going to 
be displayed in the Quick Report Editor therefore allowing or 
disallowing access to the wizard. By default, this value is set to 0 (no 
access to the wizard).

■ search (boolean)
This parameter indicates whether the New Query button and the 
Master table drop-down menu are going to be displayed in the quick 
report editor therefore allowing or disallowing modification of the 
current table and current master table. By default, this value is set to 0 
(no access to the modifications).

The Quick Report editor allows users to create their own reports. When 
the Quick Report editor is displayed, the user is in the same context as 
when the editor is displayed in user mode, at the exception of the 
possible presence of the Master table selection drop-down list and of 
the New Query button. The user has complete control over the editor.

If the Quick Report editor is not involved, the OK variable is set to 1 if 
a report is printed; it is set to 0 (zero) if not (i.e., if the user clicked 
Cancel in the printing dialog boxes).

■ *
After a report is selected, the dialog boxes for printing are displayed, 
unless the * parameter is specified. If this parameter is specified, these 
dialog boxes are not displayed. The report is then printed.

❿❿❿❿ Examples:

1. The following example lets the user query the [People] table, and 
then automatically prints the report "Detailed Listing":

QUERY ([People])
If (OK=1)

REPORT ([People];"Detailed Listing";False;False;False*)
End if

2. The following example lets the user query the [People] table, and 
then lets the user choose which report to print:

QUERY ([People])
If (OK=1)

QR REPORT ([People];"";False;False;False)
End if



Chapter 2  Language

82 Quick Report Editor Reference

3. The following example lets the user query the [People] table, and 
then displays the Report editor so the user can design, save, load and 
print any reports:

QUERY ([People])
If (OK=1)

QR REPORT ([People];Char(1);False;False;False)
End if

QR REPORT TO 
BLOB

QR REPORT TO BLOB (area;blob)

The QR REPORT TO BLOB command places the report whose reference 
was passed in area in a BLOB (variable or field).

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid blob parameter, the error 64 will be generated 
(“A picture field or variable was esxpected”).

The following statement assigns the Quick Report stored in MyArea 
into a BLOB Field.

QR REPORT TO BLOB (MyArea;[Table 1]Field4)

QR RUN QR RUN(area)

The QR RUN command executes the report area whose reference was 
passed as parameter with the Quick Report current settings, including 
the output type.

If you pass an invalid area number, the error 9850 will be generated.

QR SET AREA 
PROPERTY

QR SET AREA PROPERTY(area;property;value)

Parameters Type Description
area Longint → Reference of the area
blob BLOB ← Blob that houses the Quick Report

Parameters Type Description
area longint → Reference of the area to execute

Parameters Type Description
area Longint → Reference of the area
property Longint → Palette designated
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The QR SET AREA PROPERTY command allows you to display or hide the 
interface element (palette or menu bar) whose reference is passed in 
option.

The menu bar and toolbars are numbered from 1 to 6 (top to bottom) 
and the value 7 is dedicated to the contextual menu.

You can use the constants from the QR Area Properties theme to desig-

nate the interface item.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid property parameter, the error 9852 will be 
generated.

QR SET BORDERS QR SET BORDERS(area ; column ; row; border; line{ ;color})

value Longint → 0 = visible
1 = invisible

Property Constant Description
Menu bar QR view 

menubar (1)
Display status of the menu bar
(Displayed=1, Hidden=0)

Standard palette QR view stan-
dard toolbar (2)

Display status of the Standard palette
(Displayed=1, Hidden=0)

Style palette QR view style 
toolbar (3)

Display status of the Style palette
(Displayed=1, Hidden=0)

Computation 
palette

QR view compu-
tation toolbar 
(4)

Display status of the Computation 
palette (Displayed=1, Hidden=0)

Column palette QR view col-
umn toolbar (5)

Display status of the Column palette
(Displayed=1, Hidden=0)

Color palette QR view color 
toolbar (6)

Display status of the Color palette
(Displayed=1, Hidden=0)

Contextual 
menu

QR view contex-
tual menu (7)

Display status of the Contextual 
menu (Displayed=1, Hidden=0)

Parameters Type Description

Parameters Type Description
area Longint → Reference of the area
column Longint → Column number
row Longint → Row number
border Longint → Border composite value
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The command QR SET BORDERS allows you to set the border style for a 
given cell.

area is the reference of the Quick Report area.

column is the column number of the cell.

row is the row number of the cell.

border is a composite value that indicates whose borders of the cell are 
to be affected:

■ 1 indicates the left border

■ 2 indicates the top border

■ 4 indicates the right border

■ 8 indicates the bottom border

For example, a value of 5 passed in border would affect the right and 
left borders.

line is the thickness of the line:

■ 0 indicates no line

■ 1 indicates a thickness of 1/4 point

■ 2 indicates a thickness of 1/2 point

■ 3 indicates a thickness of 1 point

■ 4 indicates a thickness of 2 points

color is the color of the line:

■ If color is a positive value, it indicates a specific color.

■ If color equals 0, the color is black.

■ If color equals -1, no changes are to be made.

Note The default color is black.

QR SET 
DESTINATION

QR SET DESTINATION(area; destination; {specifics})

line Longint → Line thickness
color Longint → Border color

Parameters Type Description

Parameters Type Description
area Longint → Reference of the area
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The QR SET DESTINATION command sets the output type of the report for 
the area whose reference was passed in area.

■ Text File (2) :
If you pass an empty string as the file’s pathname, a Save file dialog is 
going to be displayed, otherwise the file is saved at the location 
indicated by the path.

The default field delimiter is the tab character (ASCII 9). The default 
record delimiter is the carriage return character (ASCII 13). You can 
change these defaults by assigning values to the two delimiter system 
variables: FldDelimit and RecDelimit. If under Windows, FldDelimit 
equals 13, a char 10 (line feed) will be appended after the carriage 
return. Be aware that these variables are used by other commands such 
as IMPORT TEXT for example. Changing them for the quick Report 
editor, changes them everywhere in the application.

■ 4D View (3) :
If  4D View is active for the user, a 4D View external window is created 
and populated with the results of the current settings of the Quick 
Report area.

■ 4D Chart(4):
A 4D Chart external window is created and populated with the results 
of the current settings of the Quick Report area. For detailed 
information on how the translation is performed, please refer to the 
User Reference section of the Quick Report Editor documentation.

type Longint → Type of the report
specifics String |

Variable
→ Specifics linked to the output type

Destination Constant 
(value) Specifics

Printer QR Printer (1) N.A.
Text file QR Text File (2) File pathname
4D View QR 4D View Area 

(3)
N.A.

4D Chart QR 4D Chart 
Area (4)

N.A.

HTML file QR HTML File (5) Pathname to the HTML file

Parameters Type Description
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■ HTML file(5):
An HTML file is created using the template set by SET HTML TEMPLATE. 
For detailed information on how the translation is performed, please 
refer to the User Reference section of the Quick Report Editor 
documentation.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid destination value, the error 9852 will be 
generated.

The following code sets the destination as being the text file Mydoc.txt 
and executes the Quick Report:

QR SET DESTINATION(MyArea; 2; “MyDoc.txt“)
QR RUN(MyArea)

QR SET DOCUMENT 
PROPERTY

QR SET DOCUMENT PROPERTY(area;option;value)

The QR SET DOCUMENT PROPERTY command allows you to display the 
printing dialog or to define the unit used for the document.

■ If property equals 1, the command applies to display of the print 
dialog.

■ If value equals 1, the print dialog is displayed prior to printing.

■ If value equals 0, the print dialog is not displayed prior to printing.

■ If property equals 2, the command applies to the document unit.

■ If value equals 0, the document’s unit is points.

■ If value equals 1, the document’s unit is centimeters.

■ If value equals 2, the document’s unit is inches.

You can use the following constants, located in the QR Document 
properties constant theme: qr Printing Dialog and qr Unit.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid property value, the error 9852 will be generated.

Parameters Type Description
area Longint → Reference of the area
property Longint → 1 = Printing dialog

0 = Document unit
value Longint → Value for the property
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QR SET HEADER 
AND FOOTER

QR SET HEADER AND FOOTER(area; selector; leftTitle; centerTitle; rightTi-

tle; height{; picture}{; pictJustification})

The QR SET HEADER AND FOOTER command allows you to set the 
contents and size of the header or footer.

selector allows you to select the header or the footer. If selector equals 
1, the header will be affected; if selector equals 2, the footer will be 
affected.

leftTitle, centerTitle and rightTitle are the values for, respectively, the 
left, center and right header/footer.

height is the height of the header/footer, expressed in the unit selected 
for the quick report.

picture is a picture that will be displayed in the header or footer.

pictAlignment is the alignment attribute for the picture passed in 
picture.

■ If alignment equals 0, the picture is aligned to the left.

■ If alignment equals 1, the picture is centered.

■ If alignment equals 2, the picture is aligned to the right.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid selector value, the error 9852 will be generated.

The following statement places the title “Center title” in the header for 
the Quick Report in MyArea and sets the header height to 200 pixels:

QR SET HEADER AND FOOTER(MyArea; 1; ““; centerTitle;””; 200)

Parameters Type Description
area Longint → Reference of the area 
selector Longint → 1 = Header

2 = Footer
leftTitle String → Text displayed on the left side
centerTitle String → Text displayed in the middle
rightTitle String → Text displayed on the right side
height Real → Header or footer height
picture Picture → Picture to display
pictAlignment Longint → alignment attribute for the picture
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QR SET HTML 
TEMPLATE

QR SET HTML TEMPLATE (area; template)

The QR SET HTML TEMPLATE command sets the HTML template 
currently used for the Quick Report area. The template will be used 
when building the report in HTML format. The template use a set of 
tags to process the data to either retain a layout close to the original 
report or to adopt your own custom HTML.

If you pass an invalid area number, the error 9850 will be generated.

Note Please note that you first need to call QR SET DESTINATION to set the 
output to HTML file.

HTML Tags ■ <!--#4DQRheader--> ... <!--/#4DQRheader-->
The HTML contents that are included between those tags come 
from the column titles. You will typically use these tags to define 
the title row of the report.

■ <!--#4DQRrow--> ... <!--/#4DQRrow-->
The HTML contents that are included between those tags are 
repeated for each data row (including detail and subtotal rows).

■ <!--col--> ... <!--/#4DQRcol-->
The HTML contents that are included between those tags are 
repeated for each data column within a row. The column order will 
remain identical to the order in the report. When used in conjunc-
tion with <!--#4DQRcol;n--> ... <!--/#4DQRcol;n-->, the tags <!--
#4DQRcol--> ... <!--/#4DQRcol--> will only go through the col-
umnns whose contents are not inserted using <!--#4DQRcol;n--> ... 
<!--/#4DQRcol;n-->.

For example, in a report that has five columns, you choose to use <!-
-#4DQRcol;2--> ... <!--/#4DQRcol;2--> to insert data from the second 
column, <!--#4DQRcol--> ... <!--/#4DQRcol--> will go, for each row 
through columns 1, 3, 4, and 5. These last tags ignore the column 
whose contents are published through <!--#4DQRcol;2--> ... <!--
/#4DQRcol;2-->

■ <!--#4DQRcol;n--> ... <!--/#4DQRcol;n-->
The HTML contents that are included between those tags are 

Parameters Type Description
area Longint → Reference of the area
template text → HTML template
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extracted from the column in the report whose number is “n”. If, 
for example, you want to display a different column order in the 
HTML output in a three-column report, you could be using:

<!--#4DQRrow--> <!--#4DQRcol;3--> ... <!--/#4DQRcol;3--><!--
#4DQRcol;2--> ... <!--/#4DQRcol;2--><!--#4DQRcol;1--> ... <!--
/#4DQRcol;1--> <!--/#4DQRrow-->
In this example, the columns are inserted in the opposite order of 
the report.

■ <!--#4DQRfont--> ... <!--/#4DQRfont-->
The HTML contents that are included between those tags will be 
assigned the font and font size of the current column or cell.

<!--#4DQRfont--> will be replaced by an HTML font definition and 
<!--/#4DQRfont--> will be replaced by the matching closing tag 
(</font-->).

■ <!--#4DQRface--> ... <!--/#4DQRface-->
The HTML contents that are included between those tags will be 
assigned the font style of the current column or cell.

<!--#4DQRface--> will be replaced by an HTML face definition and 
<!--#4DQRface--> will be replaced by the matching closing tag 
(</face-->).

■ <!--#4DQRbgcolor-->
This color tag will be replaced by the current color for the current 
cell.

■ <!--#4DQRdata-->
This tag will be replaced by the current data for the current cell.

■ <!--#4DQRlHeader-->, <!--#4DQRcHeader-->, and <!--
#4DQRrHeader-->
These tags will be replaced respectively by the data in the left, cen-
ter or right header.

■ <!--#4DQRlFooter-->, <!--#4DQRcFooter-->, and <!--#4DQRrFooter--
>
These tags will be replaced respectively by the data in the left, cen-
ter or right footer.

If you pass an invalid area number, the error 9850 will be generated.
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QR SET INFO 
COLUMN

QR SET INFO COLUMN (area; colNum; title; object; hide; size; repeated-

Value;displayFormat)

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid ColNum value, the error 9852 will be generated.

List mode The QR SET INFO COLUMN command allows you to set the parameters of 
an existing column.

area is the reference of the Quick Report area.

colNum is the number of the column to modify

title is the title that will be displayed in the header of the column.

object is the actual object of the column (variable, field or formula)

size is the size in pixels to assign to the column. If size equals -1, the 
size is made automatic.

displayFormat is the display format. Display formats are the 4D formats 
compatible with the data displayed.

repeatedValue is the status for data repetition. For example, if the value 
for a field or variable does not change from one record to the other it 
may or may not be repeated when they do not change. If repeatedValue 
equals 0, values are not repeated. If repeatedValue equals 1, values are 
repeated.

If you pass an invalid area number, the error 9850 will be generated.

Parameters Type Description
area Longint → Reference of the area
colNum Longint → Column number
title String → Title of the column
object Field | 

Variable
→ Object assigned for that column

hide Longint → 0 = visible
1 = invisible

size Longint → Column size
repeatedValue Longint → 0 = not repeated

1 = repeated
displayFormat String → Format for the data 
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If you pass an invalid ColNum value, the error 9852 will be generated.

The following statement sets the title of column #1 to Title, sets the 
contents of the body to Field2, makes the column visible with a width 
of 150 pixels and sets the format to ###.##.

QR SET INFO COLUMN(area; 1; “Title”; “[Table 1]Field2“;
0;150;0;”###,##”)

Cross-tab mode The QR SET INFO COLUMN command allows you to set the same 
parameters but the reference of the areas to which it applies is different 
and varies depending on the parameter you want to set. First of all, the 
parameters title, hide, and repeateValue are not used when that 
command is used in cross-tab mode. The value to use for column varies 
depending on whether you want to set the column size or the data 
source and display format.

■ Column size:
This is a “visual” attribute, therefore columns are numbered from left 
to right, as depicted below.

The following statement will set the size to automatic for all the 
columns in a cross-tab report and leaves other elements unchanged.

For ($i;1;3)
QR GET INFO COLUMN(qr_area;$i;$title;$obj;$hide;$size;$rep;$format)
QR SET INFO COLUMN(qr_area;$i;$title;$obj;$hide;0;$rep;$format)

End for 

You will notice that since you want to alter only the column size, you 
have to use QR GET INFO COLUMN to retrieve the column properties 

column = 1 column = 2 column = 3
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and pass them to QR SET INFO COLUMN to leave it unchanged, except 
for the column size.

■ Data source (object) and display format
In this case the numbering of columns operates as depicted below:

You will notice that not all cells can be addressed through the 
command QR SET INFO COLUMN, the cells that are not numbered 
above are addressed through QR SET TOTALS DATA.

The following code assigns data sources to the three cells required for 
creating a basic cross-tab report:

QR SET REPORT TABLE(qr_area;Table(->[Invoices]))
ALL RECORDS([Invoices])
QR SET REPORT KIND(qr_area;2)
QR SET INFO COLUMN(qr_area;1;"";->[Invoices]Item;1;-1;1;"")
QR SET INFO COLUMN(qr_area;2;"";->[Invoices]Quarter;1;-1;1;"")
QR SET INFO COLUMN(qr_area;3;"";->[Invoices]Quantity;1;-1;1;"")

This would be the resulting report area:

column = 2 column = 3 column = 1
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QR SET INFO ROW QR SET INFO ROW (area; row; hide)

The QR SET INFO ROW command displays/hides the row whose reference 
was passed in row.

row designates which row is affected:

■ if row equals -1, the title of the report is affected

■ if row equals -2, the detail of the report is affected

■ if row equals -3, the grand total of the report is affected

■ if row is a positive integer, it designates the subtotal (break) level 
that is affected

You can use constants from the QR Rows for Properties theme to 
designate the row item. (qr title= -1, qr detail=-2, qr grand total=-3)

hide specifies whether the line is visible or hidden. If hide equals 1, the 
row is set to hidden; if hide equals 0, the row is set to visible.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid row value, the error 9852 will be generated.

The following statement hides the detail row:

QR SET INFO ROW (area; -2; 1)

QR SET REPORT 
KIND

QR SET REPORT KIND(area;type)

The QR SET REPORT KIND command sets the report type for the area 
whose reference was passed in area.

■ If type equals 1, the report type is list

■ If type equals 2, the report type is cross-tab

Parameters Type Description
area Longint → Reference of the area created
row Longint → Row designator
hide Longint → 0= visible

1= hide

Parameters Type Description
area Longint → Reference of the area
type Longint → Type of the report
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If you set a new type for an existing current report, it removes the 
previous settings and creates a new empty report, ready to be set.

You can also use the constants qr List Report and qr Cross Report from 
the theme QR Report Types.

QR SET REPORT 
TABLE

QR SET REPORT TABLE (area; table)

The QR SET REPORT TABLE command sets the current table for the 
report area whose reference was passed in area to the table whose 
number was passed in table.

It is critical that a table is assigned to the report since the report editor 
will be using the current selection for that table to display the data, 
perform computations and propagate relations, if needed.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid table value, the error 9852 will be generated.

QR SET SELECTION QR SET SELECTION(area;left;top;right;bottom)

The QR SET SELECTION command allows you to highlight a cell, a row 
a column or the entire area as you would with a mouse click. It also 
allows you to deselect the current selection.

left is the number of the left boundary. If left equals 0, the entire row is 
selected.

top is the number of the top boundary. If top equals 0, the entire 
column is selected.

right is the number of the right boundary.

Parameters Type Description
area Longint → Reference of the area
table Longint → Table number

Parameters Type Description
area Longint → Reference of the area
left Longint → Left boundary
top Longint → Top boundary
right Longint → Right boundary
bottom Longint → Bottom boundary
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bottom is the number of the bottom boundary.

Notes If both left and top equal 0, the entire area is highlighted.

If you want no selection, pass -1 to left, right, top and bottom.

If you pass an invalid area number, the error 9850 will be generated.

QR SET SORTS QR SET SORTS(area;aColumns;{aOrders})

The QR SET SORTS command allows you to set the sort orders for the 
columns in the report whose reference is passed in area.

■ aColumns
In this array, you need to store the column numbers of columns to 
which you want to assign a sort order.

■ aOrders
Each element of this array must contain the sort orders for the 
matching column in the aColumns array. 

■ If aOrders{$i} equals 1, the sort order is ascending.

■ If aOrders{$i} equals - 1, the sort order is descending.

If you pass an invalid area number, the error 9850 will be generated.

QR SET TEXT 
PROPERTY

QR SET TEXT PROPERTY(area;colNum; rowNum; property; value)

The command QR SET TEXT PROPERTY allow you to set the text 
attributes for the cell determined by colNum and RowNum.

■ area is the reference of the Quick Report area.

Parameters Type Description
area Longint → Reference of the area
aColumns Array real → Columns
aOrders Array real → Sort orders

Parameters Type Description
area Longint → Reference of the area
colNum Longint → Column number
rowNum Longint → Row number
property Longint → Operator value for the cell
value Longint → Value for the selected property
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■ colNum is the number of the cell column.

■ rowNum is the reference of the cell row.

■ if rowNum equals -1, it designates the column title.

■ if rowNum equals -2, it designates the detail area.

■ if rowNum equals -3, it designates the column grand total.

■ if rowNum equals -4, it designates the page header.

■ if rowNum equals -5, it designates the page footer.

You can use constants from the QR Rows for Properties theme to 
designate the row item. Constant Values are: qr title (-1), qr detail (-2), 
qr grand total (–3), qr header (–4),  qr footer (-5)

Note When passing -4 or -5 as rowNum, you still need to pass a column 
number in colNum, even if it is not used.

■ if rowNum s a positive value, it designates the corresponding subto-
tal (break level).

Note In cross-tab mode the principle is similar except for the row values that 
are always positive.

■ property is the value or constant of the text attribute to assign. You can 
use constants from the QR Text Properties theme to designate the pro-
perty item.

■ If property equals 1, the value is the font number as returned 
through Font number.

The following call assigns the font Times to the first column’s title:

QR SET TEXT PROPERTY(qr_area;1;-1;1;Font number("Times"))

■ If property equals 2, the value is the font size expressed in points (9 
to 255).

The following call assigns the font size 10 to the first column’s title:

QR SET TEXT PROPERTY(qr_area;1;-1;2;10)

■ If property equals 3, the value is the Bold style attribute (0 or 1).

The following call assigns the font attribute Bold to the first column’s 
title:

QR SET TEXT PROPERTY(qr_area;1;-1;3;1)

■ If property equals 4, the value is the Italic style attribute (0 or 1). 
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The following call assigns italicizes the first column’s title:

QR SET TEXT PROPERTY(qr_area;1;-1;4;1)

■ If property equals 5, the value is the Underline style attribute (0 or 
1).

The following call assigns underlines the first column’s title:

QR SET TEXT PROPERTY(qr_area;1;-1;5;1)

■ If property equals 6, the value is the Color value (longint) to apply to 
the text (Color number).

The following call assigns the color bright green to the first column’s 
title:

QR SET TEXT PROPERTY(qr_area;1;-1;6;0x0000FF00)

■ If property equals 7, the value is the text Justification attribute (0 for 
default, 1 for left, 2 for center or 3 for right).

■ If property equals 8, the value is the background color.

■ If property equals 9, the value is the alternate background color.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid colNum number, the error 9852 will be 
generated.

If you pass an invalid rowNum number, the error 9853 will be 
generated.

If you pass an invalid property number, the error 9854 will be 
generated.

QR SET TOTALS 
DATA

QR SET TOTALS DATA(area;colNum; breakNum; operator)

This command cannot create a subtotal.

If you pass an invalid area number, the error 9850 will be generated.

Parameters Type Description
area Longint → Reference of the area
colNum Longint → Column number
breakNum Longint → Break number
operator | value Longint |

String
→ Operator value for the cell or cell 

content
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If you pass an invalid colNum number, the error 9852 will be 
generated.

If you pass an invalid breakNum number, the error 9853 will be 
generated.

List Mode The QR SET TOTALS DATA command allows you to set the details of a 
specific break (total or subtotal).

area is the reference of the Quick Report area.

colNum is the column number of the cell whose data is going to be set.

breakNum is the number of the break whose data will be set(subtotal or 
grand total). For a Subtotal, breaknum is the sort number. For the 
grand total, breaknum equals -3 or the constant qr grand total.

operator is an addition of all the operators in the cell:

■ If operator equals 0, there is no operator.

■ If operator equals 1, the operator is Sum.

■ If operator equals 2, the operator is Average.

■ If operator equals 4, the operator is Max.

■ If operator equals 8, the operator is Min.

■ If operator equals 16, the operator is Count.

You can use the constants from the QR operators theme to designate 
the operator. 

value is the text to be placed in the cell.

4D Server Operator/value is mutually exclusive, so you either set an operator or a 
text.

You can pass the following values

- # for the value that triggered the break or subtotal

- ##S will be replaced by the sum.

- ##A will be replaced by the Average.

- ##C will be replaced by the Count

- ##X will be replaced by the Max.
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- ##N will be replaced by the Min.

- ##xx, where xx is a column number. This will be replaced by that 
column’s value, using its formatting. If this column does not exist, 
then it will not be replaced

Cross-tab Mode The QR SET TOTALS DATA command allows you to set the details of a 
specific cell.

area is the reference of the Quick Report area.

colNum is the column number of the cell whose data is going to be set.

breakNum is the row number of the cell whose data is going to be set.

operator is an addition of all the operators present in the cell:

■ If operator equals 0, there is no operator.

■ If operator equals 1, the operator is Sum.

■ If operator equals 2, the operator is Average.

■ If operator equals 4, the operator is Max.

■ If operator equals 8, the operator is Min.

■ If operator equals 16, the operator is Count.

You can use the constants from the QR operators theme to designate the 
operator.

value is the text to be placed in the cell.
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Here is a depiction of how the parameters column and break have to be 
combined in cross-tab mode:

Supported Types of Data:
The types of data that you can pass are of two basic kinds:

■ Title
A title is passed through the parameter value. The value is actually a 
string and can be passed only for the following cells: column=3 
breakNum =1 and column = 1 and breakNum =3.

■ Operator
An operator or a combination of operators (as described above) can be 
passed for the following cells: 

■ column=2, breakNum =2

■ column=3, breakNum =2

■ column=2, breakNum =3
Please note that these last two values affect the cell (Column 3; Row 
3) as well. If a computation is defined in the cell (Column 2; Row 3), 
the contents of the cell (Column 2; Row 3) always define the con-
tents of the cell (Column 3; Row 3).

QR SET TOTALS 
SPACING

QR SET TOTALS SPACING(area; subtotalNumber;value)

colNum = 1 colNum = 2 colNum = 3

breakNum = 1

breakNum = 2

breakNum = 3

Parameters Type Description
area Longint → Reference of the area
subtotal Longint → Column number
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The command QR SET TOTALS SPACING allows you to set a space above 
a subtotal row. It applies only to the list mode.

area is the reference of the Quick Report area.

subtotal is the subtotal level (or break level) that will be affected.

value defines the value of the spacing:

■ If value equals 0, no space is added.

■ If value equals 32000 a page break is inserted.

■ If value is a positive value, it expresses the spacing value in pixels.

■ If value is a negative value, it expresses the spacing as a percentage 
of the subtotal row. For example, -100 will set a space of 100% 
above the subtotal row.

Note If the space above a subtotal row “pushes” the row to the next page, 
there will be no space inserted above the row on that page.

If you pass an invalid area number, the error 9850 will be generated.

If you pass an invalid subtotalNumber, the error 9852 will be 
generated.

value Array real → 0: no space
32000 : inserts a page break
Positive value: spacing added at the 
top of the break level.
Negative value: proportional increase 

Parameters Type Description
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3 Constants

Theme QR Reports Types

Theme QR Destination

Theme QR Rows for Properties

Constant Value
qr list report 1
qr cross report 2

Constant Value
qr printer 1
qr text file 2
qr 4D View area 3
qr 4D Chart area 4
qr HTML file 5

Constant Value
qr title -1
qr detail -2
qr grand total -3
qr header -4
qr footer -5
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Theme QR Text Properties

Theme QR Area Properties

Theme QR Document Properties

Theme QR Operators

Constant Value
qr font 1
qr font size 2
qr bold 3
qr italic 4
qr underline 5
qr text color 6
qr justification 7
qr background color 8
qr alternate background 
color

9

Constant Value
qr view menubar 1
qr view standard toolbar 2
qr view style toolbar 3
qr view operators toolbar 4
qr view column toolbar 5
qr view color toolbar 6
qr view Contextual 
menus

7

Constant Value
qr printing dialog 1
qr unit 2

Constant Value
qr sum 1
qr average 2
qr max 4
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Theme QR Borders

Theme QR Commands

qr min 8
qr count 16

Constant Value
qr left border 1
qr top border 2
qr right border 4
qr bottom border 8
qr inside vertical border 16
qr inside horizontal 
border

32

Constant Value
qr cmd bold 500
qr cmd italic 501
qr cmd underline 502
qr cmd left justified 503
qr cmd center justified 504
qr cmd right justified 505
qr cmd sum 506
qr cmd average 507
qr cmd min 508
qr cmd max 509
qr cmd count 510
qr cmd plain 511
qr cmd default justified 512
qr cmd font dropdown 1000
qr cmd font color palette 1002
qr cmd back color palette 1003
qr cmd new 2000
qr cmd open 2001
qr cmd save 2002
qr cmd save as 2003

Constant Value
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qr cmd revert to save 2004
qr cmd header and footer 2005
qr cmd page setup 2006
qr cmd print preview 2007
qr cmd execute 2008
qr cmd style toolbar 2050
qr cmd operators toolbar 2051
qr cmd back colors 
toolbar

2052

qr cmd standard toolbar 2053
qr cmd columns toolbar 2054
qr cmd printer 
destination

2500

qr cmd disk file 
destination

2501

qr cmd graph destination 2502
qr cmd 4D view 
destination

2503

qr cmd HTML file 
destination

2504

qr cmd insert column 2600
qr cmd delete column 2601
qr cmd hide column 2602
qr cmd edit column 2603
qr cmd repeated values 2604
qr cmd automatic width 2605
qr cmd format 2606
qr cmd hide line 2607
qr cmd add column 2608
qr cmd borders 2609
qr cmd totals spacing 2610
qr cmd move left 3002
qr cmd move right 3003

Constant Value
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4 Error Codes

9850: Invalid area parameter passed to an external command.

9851: Invalid parameter number 1.

9852: Invalid parameter number 2.

9853: Invalid parameter number 3.

9854: Invalid parameter number 4.

9855: Invalid parameter number 4.
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5 Basic Form Examples

Creating a Basic List Form
This section describes a basic example of list form. Here we will des-
cribe a basic hard-coded report. This is just an example of how to pro-
ceed with basic column assignment, breaks, and titles. In “real life” 
you would most likely not use a hard-coded report, you would either 
create it manually first and then store it or provide the interface to let 
your users define a form manually. In this example, the data consists of 
item sales that are stored in a single table. In this table there are the fol-
lowing fields:
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This table is an invoice table where each invoice record has a country 
of purchase, an item denomination, a number of items and a quarter 
of purchase. The typical data would look as follows:
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The report we are going to create should look like this:

The idea here is to display play each invoice for a given country, sorted 
by equipment type and by country. You will notice that the 
equipement type and coutry are not repeated for each record, they are 
displayed only when their value change.
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Here is the Quick Report area as it should appear in the dialog:

Here is the code from which it originated:

QR SET REPORT KIND(qr_area;1)
QR SET REPORT TABLE(qr_area;Table(->[Invoices]))
ARRAY REAL($ColOrdered;3)
ALL RECORDS([Invoices])
QR INSERT COLUMN(qr_area;1;->[Invoices]Quantity)
QR INSERT COLUMN(qr_area;1;->[Invoices]Item)
QR INSERT COLUMN(qr_area;1;->[Invoices]Country)
QR SET INFO COLUMN(qr_area;1;"Nation";->[Invoices]Country;0;-1;0;"")
QR SET INFO COLUMN(qr_area;2;"Device";->[Invoices]Item;0;-1;0;"")
QR SET INFO COLUMN(qr_area;3;"Quantity sold";->[Invoices]Quantity;0;-
1;0;"")
For ($i;1;3)

$ColOrdered{$i}:=$i
End for 
ARRAY REAL($Orders;3)
For ($i;1;3)
$Orders{$i}:=1
End for 
QR SET SORTS(qr_area;$ColOrdered;$Orders)
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QR SET TOTALS DATA(qr_area;3;3;1)
QR SET TOTALS DATA(qr_area;2;3;"Accumulated orders")

This code is applied to a new Quick Report document stored whose 
plug-in area is named qr_area.

Initializing the New 
Quick Report

The first three line are dedicated to choices that are usually taking 
place at the inception of the report:

QR SET REPORT KIND(qr_area;1)

This statement sets the report type to List. By default, the report type is 
List, but it is advisable to actually always force it, so that you always 
know which report type is selected.

QR SET REPORT TABLE(qr_area;Table(->[Invoices]))

This statement tells 4D what table is to load. It is mandatory to select a 
table for a report since 4D will otherwise only load the table of the 
form that houses the Quick Report area. This could interfere with the 
actual contents of the selection on which the report is based.

Column Insertion 
and Modification

This is handle by the following code:
QR INSERT COLUMN(qr_area;1;->[Invoices]Quantity)
QR INSERT COLUMN(qr_area;1;->[Invoices]Item)
QR INSERT COLUMN(qr_area;1;->[Invoices]Country)
QR SET INFO COLUMN(qr_area;1;"Nation";->[Invoices]Country;0;-1;0;"")
QR SET INFO COLUMN(qr_area;2;"Device";->[Invoices]Item;0;-1;0;"")
QR SET INFO COLUMN(qr_area;3;"Quantity sold";->[Invoices]Quantity;0;-
1;0;"")

The command QR INSERT COLUMN is used to create the columns by 
inserting them one by one. You will notice, that, since this is an 
insertion of the first column each time, it sequence begins with the 
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rightmost column first. After these statements, the area would look like 
this:

You will notice that the default column titles are the field names and 
you may want them to be replaced by their interface names.

This is achieved through the use of the command QR SET INFO 
COLUMN:
QR SET INFO COLUMN(qr_area;1;"Nation";->[Invoices]Country;0;-1;0;"")
QR SET INFO COLUMN(qr_area;2;"Device";->[Invoices]Item;0;-1;0;"")
QR SET INFO COLUMN(qr_area;3;"Quantity sold";->[Invoices]Quantity;0;-
1;0;"")

The calls above are very similar to calls to the QR INSERT COLUMN 
command: they assign a new column title, specify the data source 
again, make sure the column is visible, that its size is automatic and 
that values are not repeated.

Creating Break 
Levels

Break levels are created by sorts levels through the statement:
QR SET SORTS(qr_area;$ColOrdered;$Orders)
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QR SET SORTS accepts two arrays: one for the columns that are to be 
sorted and another one for the actual sort orders. 

In our examples the two arrays affect an ascending order to all the 
colummns. They are handled by the following loops:
For ($i;1;3)

$ColOrdered{$i}:=$i
End for 
ARRAY REAL($Orders;3)
For ($i;1;3)
$Orders{$i}:=1
End for 

By now, the quick report area looks as follows:

You will notice that the subtotal levels have been created and you can 
now assign them dedicated contents (title, calculations, variables etc.).

Assigning 
Break Data

This is handled by the following code:
QR SET TOTALS DATA(qr_area;3;3;1)
QR SET TOTALS DATA(qr_area;2;3;"Accumulated orders")
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The first statement assigns a sum to the third break level. This will 
display the sum of all invoices for a specific product in a specific 
country.

The next statement assigns a static content to the second column of 
the third break area: “Accumulated orders“ in this case. This is how 
you will display a title for a break area.

Creating a Basic Cross-tab Report
This section describes a basic example of a Cross-tab report. Here, we 
will describe a basic hard-coded report. This is just an example of how 
to proceed with basic column assignment, breaks, and titles. In “real 
life” you would most likely not use a hard-coded report, you would 
either create it once manually and then store it, or provide the inter-
face to let your users define a form manually. In this example, the data 
is similar to that used in the previous example.

In this example, we are trying to create a table that describes the sales 
volume by quarters:

If, for example, we have a closer look at the first column, we obtain 
from top to bottom the sales were 34 units for Q1, 48 for Q2 and so on. 
There were 195 AV preamplifiers sold, the invoice quantity average is 
slightly above 5.9 and the minimum quantity is 1.
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Here is the report as it should appear in the Quick Report area: 

As with the previous example, the report is hard-coded. This time the 
code is as follows:

` Cross table report builder 
` We go into cross mode

QR SET REPORT KIND(qr_area;2)
QR SET REPORT TABLE(qr_area;Table(->[Invoices]))

` Sets the column source. 
` Those are the fields that will become column title
` Column is 1, title is unused in cross-table mode
` visible is unused, width is set to automatic, and repeat is unused

QR SET INFO COLUMN(qr_area;1;"";->[Invoices]Item;1;-1;1;"")
` Sets the column total title

QR SET TOTALS DATA(qr_area;3;1;"Line Total")

` Sets the line source. Those are the fields that will become line titles
` Column is 2, title is unused in cross-table mode
` visible is unused, width is set to automatic, and repeat is unused

QR SET INFO COLUMN(qr_area;2;"";->[Invoices]Quarter;1;-1;1;"")
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  ` Sets the cell source. This field/formula has to be numeric/Time
  ` Column is 3, title is unused in cross-table mode
  ` visible is unused, width is set to automatic, and repeat is unused
QR SET INFO COLUMN(qr_area;3;"";->[Invoices]Quantity;1;-1;1;"")
  ` Now, we set the computation we want in those cells.
QR SET TOTALS DATA(qr_area;2;2;1)

  ` Now, we setup the line computation.
QR SET TOTALS DATA(qr_area;3;2;3)

  ` Now we can setup the grand total label
QR SET TOTALS DATA(qr_area;1;3;"Grand total")

  ` The column computation
QR SET TOTALS DATA(qr_area;2;3;7)

You will notice that the entire process is actually simpler with a Cross-
tab report than with a List report. This is explained by the fact that a 
Cross-tab report uses only three data sources: one for the columns, one 
for the lines and one for the center cell. Once they have been defined 
you can define additional calculations for the cells.

Initializing the New 
Quick Report

The first two lines are dedicated to choices that are usually taking place 
at the inception of the report:

QR SET REPORT KIND(qr_area;2)

This statement sets the report type to Cross-tab. By default, the report 
type is List, so it is mandatory to switch to the Cross-tab mode.

QR SET REPORT TABLE(qr_area;Table(->[Invoices]))

This statement tells 4D what table is to load. It is mandatory to select a 
table for a report since 4D will otherwise only load the table of the 
form that houses the Quick Report area. This could interfere with the 
actual contents of the selection on which the report is based.

Setting 
the Data Sources

The first step that follows initialization is defining the data sources. As 
specified earlier, there will be one data source for the columns and one 
data source for the lines.

The first statement sets the data source for the column. You will notice 
that the parameters title, visible and repeated are not used in cross-tab 
mode. That statement also sets the width to Automatic. 
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QR SET INFO COLUMN(qr_area;1;"";->[Invoices]Item;1;-1;1;"")

The next statement sets to “Line total“ the title for the Total column:

QR SET TOTALS DATA(qr_area;3;1;"Line Total")

At this point, the next step is to assign a data source to the line. We 
will use a similar statement, at the exception of the column number 
that is now 2 and of the data source, which changes:

QR SET INFO COLUMN(qr_area;2;"";->[Invoices]Quarter;1;-1;1;"")

The width is set to Automatic and the parameters title, repeated, and 
visible are unused.

Once the data sources for both the column and the line have been 
defined, you need to define the data source for the column cell:

QR SET INFO COLUMN(qr_area;3;"";->[Invoices]Quantity;1;-1;1;"")

Here the column number is 3 and the data source has to be a numeric 
or a time type. Here, is the Quantity (per invoice field).

At this point, the Quick Report area looks like this:



Chapter 5  Basic Form Examples

120 Quick Report Editor Reference

The data sources have now been set, the additional computations 
remain to be set as well as the title for the grand total line:

The following statement sets the computation for the cell to Sum.
QR SET TOTALS DATA(qr_area;2;2;1)

The following statement sets the computation for the line to Sum and 
Average.

QR SET TOTALS DATA(qr_area;3;2;3)

The following statement sets the title for the bottom line to “Grand 
Total“.

QR SET TOTALS DATA(qr_area;1;3;"Grand total")

Finally, the last statement inserts the computations (Sum, Average and 
Min) for the entire Grand Total line:

QR SET TOTALS DATA(qr_area;2;3;7)

At this point, the Quick Report area is set as needed:
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